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1
Начало работы с LabVIEW
Виртуальные приборы

Программы, созданные в среде LabVIEW, называются виртуальными приборами,
или, сокращенно, ВП, потому что их вид и функционирование имитируют физиче-
ские приборы, такие как осциллограф или мультиметр. Среда LabVIEW содержит
обширный набор инструментальных средств для сбора, анализа, представления и
хранения данных, а также инструменты, помогающие отладить создаваемый код. 

Написание программы в LabVIEW начинается с создания интерфейса пользовате-
ля (или, по-другому, лицевой панели), содержащего элементы управления и инди-
каторы. Примерами элементов управления являются ручки управления, кнопки,
круговые шкалы и другие элементы ввода. Индикаторами являются графики, све-
тодиодные индикаторы и другие элементы вывода. После создания интерфейса
пользователя, вы можете создать на блок-диаграмме код, используя другие вирту-
альные приборы (ВП) и структуры для управления объектами лицевой панели.

Программная среда LabVIEW может применяться для коммуникации с аппаратны-
ми средствами, такими как устройства сбора данных, системы технического зрения
и управления движением, а также GPIB, PXI, VXI, RS232 и RS485 устройствами.

В следующем упражнении мы создадим ВП, который генерирует сигнал и
выводит этот сигнал на графический индикатор (график осциллограмм).

После того, как вы завершите упражнение, лицевая панель виртуального прибора
должна выглядеть так, как показано на рисунке 1-1.

Выполнение этого упражнения займет у вас около 40 минут.

Рисунок 1-1. Лицевая панель ВП Получение сигнала

Создание виртуального прибора



Запуск LabVIEW
При запуске LabVIEW на экране появится окно первоначального запуска Getting
Started, показанное на рисунке 1-2. Это окно используется, когда требуется со-
здать новый ВП, открыть созданный ранее файл LabVIEW, найти примеры или
обратиться к справке. Здесь же вы можете найти дополнительную информацию и
ресурсы, помогающие освоить работу в среде LabVIEW, такие как специальные
руководства и разделы справочника, а также Интернет ресурсы на сайте ni.com
компании National Instruments.
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Окно первоначально запуска Getting Started исчезнет, если открыть уже сущест-
вующий файл или создать новый. Это окно появится снова, если закрыть все ра-
нее открытые лицевые панели и блок-диаграммы. Также это окно можно вызвать
в процессе работы из лицевой панели или блок-диаграммы, выбрав меню
View » Getting Started Window.

Рисунок 1-2. Окно Getting Started

Создание нового ВП из шаблона
В LabVIEW содержатся встроенные шаблоны ВП, содержащие виртуальные под-
приборы (ВПП), функции, структуры и объекты лицевой панели, которые могут
потребоваться при создании базовых приложений для выполнения различных
измерений.

Выполните следующие шаги для создания ВП, который генерирует сигнал и ото-
бражает его на лицевой панели.

1. Запустите LabVIEW. 

2. В окне Getting Started, щелкните по ссылке New, или VI from Template (ВП из
Шаблона) чтобы появилось диалоговое окно New.

3. Из списка Create New, выберите VI » From Template » Tutorial (Getting Started)
» Generate and Display (ВП » Из шаблона » Обучение (Введение) » Генерация и Отоб-
ражение).

Этот шаблон предназначен для создания ВП, который генерирует и отобража-
ет сигнал. Предварительный просмотр и краткое описание шаблона ВП мож-
но увидеть в разделе Description (Описание). На рисунке 1-3 показано диалого-
вое окно New и эскиз шаблона ВП Генерация и Отображение.



4. Щелкните OK, чтобы создать ВП из шаблона. Также для этого можно дважды
щелкнуть по названию шаблона ВП в списке Create New.

5. Изучите лицевую панель ВП.

Интерфейс пользователя, или лицевая панель, имеет серый фон рабочего про-
странства и включает элементы управления и индикаторы. Строка заголовка
лицевой панели указывает, что это окно – лицевая панель для ВП Генерация и
Отображение.

Примечание: Если лицевая панель не видна, можно сделать ее видимой/активной, выбрав меню
Window » Show Front Panel (Окно » Показать Лицевую панель). Вы всегда можете переключиться между
окном лицевой панели и блок-диаграммой, нажав сочетание клавиш <Ctrl-E>. Клавише <Ctrl> соот-
ветствует клавиша <Option> или <Command> (Mac OS) или клавиша <Alt> (Linux).

6. Выберите меню Window » Show Block Diagram (Окно » Показать Блок-диаграм-
му) и изучите блок-диаграмму ВП.

Блок-диаграмма имеет белый фон рабочего пространства и содержит ВП и
структуры, которые управляют объектами лицевой панели. Строка заголовка
блок-диаграммы указывает, что это окно – блок-диаграмма для ВП Генерация
и Отображение.

7. На панели инструментов интерфейса пользователя щелкните кнопку Run
(Пуск), показанную слева. Так же для того, чтобы запустить ВП, можно нажать
комбинацию клавиш <Ctrl-R>.

На графическом индикаторе лицевой панели отобразится синусоида.

8. Щелкните кнопку "Стоп" (показана слева) на лицевой панели, чтобы остано-
вить ВП.
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Рисунок 1-3. Диалоговое окно New



Изменение типа сигнала
На блок-диаграмме присутствует иконка голубого цвета, с названием Simulate
Signal. Эта иконка представляет экспресс-ВП Simulate Signal. По умолчанию экс-
пресс-ВП Simulate Signal моделирует синусоиду. 

Выполните следующие шаги, чтобы изменить этот сигнал на пилообразный.

1. Перейдите на блок-диаграмму, нажав комбинацию клавиш <Ctrl-E> или щелк-
нув кнопкой мыши по блок-диаграмме. 

Найдите на ней экспресс-ВП Simulate Signal, показанный слева. Экспресс-ВП –
такой элемент блок-диаграммы, который вы можете конфигурировать для вы-

Добавление элемента управления на Лицевую панель
Элементы управления лицевой панели моделируют устройства ввода на физиче-
ском приборе и обеспечивают данными блок-диаграмму ВП. Большинство физи-
ческих приборов имеют ручки управления, поворачивая которые можно менять
входные значения.

Чтобы добавить ручку управления, необходимо выполнить следующие шаги:

Подсказка: В процессе выполнения упражнений вы можете отменить последние изменения, выбрав
опцию Undo в меню Edit или нажав комбинацию клавиш <Ctrl-Z>.

1. Если палитра элементов, показанная на рисунке 1-4, не видна на лицевой па-
нели, выберите меню View » Controls Palette.
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Подсказка: Для того чтобы появились палитра элементов управления или палитра функций, можно
щелкнуть правой кнопкой мыши на любом свободном месте лицевой панели или блок-диаграммы.
При этом палитра элементов управления или функций появляется со значком "булавки" в левом верх-
нем углу. Щелкните по нему, чтобы закрепить палитру, и тогда она будет присутствовать постоянно.

2. Если вы впервые запускаете LabVIEW, палитра элементов управления по умол-
чанию появится с открытой подпалитрой Express. Если эта подпалитра не вид-
на, щелкните Express в палитре элементов управления.

3. Перемещайте курсор мыши по значкам на подпалитре Express, чтобы найти
подпалитру числовых элементов управления Numeric. Когда вы перемещаете
курсор по значкам в палитре элементов управления, название подпалитры,
элемента управления/индикатора появляется в поле подсказки под значком.

4. Щелкните по значку Numeric Controls, чтобы отобразить подпалитру числовых
элементов управления/индикаторов.

5. Щелкните по вращающейся ручке (Knob) в палитре Numeric, чтобы прикре-
пить элемент управления к курсору, затем поместите ручку на лицевую панель,
слева от графика. Эта ручка будет использоваться в следующем упражнении
для управления амплитудой сигнала.

6. Выберите меню File » Save As (Файл » Сохранить Как) и сохраните ВП как По-
лучение сигнала.vi в заранее определенном месте.

Рисунок 1-4. Палитра элементов управления



полнения стандартных измерительных задач. А именно, экспресс-ВП Simulate
Signal моделирует сигнал, на основании той конфигурации, которую вы зададите.

2. Щелкните правой кнопкой мыши на экспресс-ВП Simulate Signal и выберете
Properties (Свойства) из контекстного меню, чтобы отобразить диалоговое ок-
но Configure Simulate Signal (настройка моделируемого сигнала). 

{Mac OS} При нажатии клавиши <Command> выполнится действие, аналогич-
ное щелчку правой кнопки мыши.

Чтобы появилось диалоговое окно Configure Simulate Signal (настройка модели-
руемого сигнала), можно также дважды щелкнуть правой кнопкой мыши по
экспресс-ВП Simulate Signal. 

Если подсоединить проводники с входными значениями к экспресс-ВП
Simulate Signal и запустить его, экспресс-ВП покажет реальные данные в диа-
логовом окне настройки. Если закрыть и снова открыть экспресс-ВП, он будет
показывать пример данных безотносительно входных значений в диалоговом
окне настройки до тех пор, пока ВП не будет снова запущен.

3. Выберите Sawtooth (пилообразный сигнал) из выпадающего меню Signal type
(тип сигнала). Форма сигнала на графике, в разделе предварительного просмо-
тра результата, изменится на пилообразную. Диалоговое окно Configure
Simulate Signal (настройка моделируемого сигнала) должно выглядеть так же,
как на рисунке 1-5.
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4. Нажмите кнопку ОК, чтобы сохранить текущие настройки и закрыть диалого-
вое окно Configure Simulate Signal.

5. Наведите курсор мыши на двойные стрелки внизу иконки экспресс-ВП Simulate
Signal. Стрелки показывают, что ВП имеет скрытые входные и выходные терми-
налы, которые можно сделать видимыми, если растянуть границу ВП.

6. Когда появится двунаправленная стрелка, показанная слева, переместите гра-
ницу экспресс-ВП так, чтобы добавились две строки. После выполнения дан-
ной операции появится вход Amplitude (амплитуда). 

Теперь у вас появилась возможность регулировать амплитуду пилообразного
сигнала.

Обратите внимание, что амплитуда – это опция диалогового окна Configure
Simulate Signal (рисунок 1-5). Когда входы, например, амплитуда, присутству-
ют и на блок-диаграмме и в диалоговом окне настройки, их значение можно
менять в любом месте.

Рисунок 1-5. Диалоговое окно Configure Simulate Signal



Соединение объектов на блок-диаграмме
Чтобы использовать вращающуюся ручку для изменения амплитуды сигнала,
необходимо соединить ее с входом Amplitude (Амплитуда) экспресс-ВП Simulate
Signal. 

Для этого выполните следующие шаги:

1. На блок-диаграмме наведите курсор на терминал элемента управления Knob
(вращающаяся ручка), показанный слева.

Курсор мыши станет стрелкой (инструментом Позиционирования), как
показано слева. Этот инструмент используется для выбора, размещения или
изменения размеров объектов.

2. Выделите терминал Knob (вращающаяся ручка) с помощью инструмента
Позиционирования. Убедитесь, что он находится слева от экспресс-ВП
Simulate Signal и внутри серого контура, показанного слева.

Терминалы внутри контура являются представлением элементов управления,
расположенных на лицевой панели. Терминалы – точки ввода/вывода, через
которые происходит обмен информацией между лицевой панелью и блок-
диаграммой.

3. Снимите выделение с терминала Knob (вращающаяся ручка), щелкнув в пустом
месте блок-диаграммы. В будущем, чтобы использовать другие инструменты
при работе с объектами, необходимо предварительно снять выделение с
объекта и затем переключиться на нужный инструмент.

4. Поместите курсор над стрелкой на терминале Knob (вращающаяся ручка), как
показано слева. Курсор примет вид катушки, или Wiring tool (инструмент
соединения). Используйте этот инструмент для соединения объектов на блок-
диаграмме.

5. Когда появится инструмент Соединения, щелкните левой кнопкой мыши по
стрелке на терминале Knob, а затем по стрелке на входе Амплитуда экспресс-
ВП Simulate Signal, как показано слева, чтобы соединить эти объекты вместе.
Появится проводник, соединяющий объекты. Данные будут передаваться по
этому проводнику от терминала Knob (вращающаяся ручка) к экспресс-ВП.

6. Выберите меню File » Save (Файл » Сохранить), чтобы сохранить ВП.

Запуск ВП
Решение получается в процессе исполнения ВП.

Выполните следующие шаги, чтобы запустить ВП Получение сигнала.

1. Переключитесь на лицевую панель, нажав комбинацию клавиш <Ctrl-E> или
щелкнув по ней.

2. Нажмите кнопку Run (Пуск) или клавиши <Ctrl-R> для запуска ВП.

3. Поместите курсор над ручкой управления.

Курсор примет вид руки, т.е. перейдет в режим Operating tool (инструмент Уп-
равление), как показано слева. Используйте его, чтобы менять значение эле-
мента управления.

4. Используя инструмент управления, поверните ручку, чтобы скорректировать
амплитуду пилообразного сигнала.

Амплитуда пилообразного сигнала изменяется настолько, насколько Вы повора-
чиваете ручку. При этом инструмент Управление будет показывать поле подсказ-
ки, в котором будет отображаться текущее числовое значение. Ось Y на графике
масштабируется автоматически, подстраиваясь под изменение амплитуды. 

Чтобы показать, что данный ВП выполняется, кнопка Run (пуск) изменяется
на затемненную стрелку, которая показана слева. Во время выполнения ВП,
можно изменять значения большинства элементов управления, но редактиро-
вать ВП нельзя.
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5. Чтобы остановить ВП, щелкните по кнопке STOP (стоп), которая показана
слева. Кнопка STOP останавливает ВП после того, как он закончит выполне-
ние текущей итерации. Кнопка Abort Execution (прервать выполнение), кото-
рая показана слева, останавливает ВП немедленно, до окончания текущей ите-
рации. Прерывание работы ВП, использующего внешние ресурсы, например
внешние аппаратные средства, может оставить ресурсы в неизвестном состоя-
нии, не сбросив или не освободив их должным образом. Снабдите ВП, кото-
рый вы создаете, кнопкой остановки, чтобы обойти эту проблему.

Преобразование сигнала
Выполните следующие шаги, чтобы увеличить амплитуду сигнала в 10 раз и вы-
вести результат на график на лицевой панели.

1. На блок-диаграмме, используя инструмент Перемещение, дважды щелкните
по проводнику, который соединяет экспресс-ВП Simulate Signal с терминалом
графика осциллограммы (показано слева).

2. Нажмите клавишу <Delete>, чтобы удалить этот проводник.

3. Если палитра Функций, которая показана на рисунке 1-6, не отображается, вы-
берите меню View » Functions Palette (Вид » Палитра Функций), чтобы сделать
ее видимой. Палитра Функций по умолчанию открывается вместе с подпалит-
рой Express. Если выбрана другая подпалитра, можно вернуться к подпалитре
Express, нажав "Express" в палитре Функций.

4. В палитре Arithmetic & Comparison palette (Арифметика и Сравнение), выбери-
те экспресс-ВП Formula (Формула) (показан слева), и разместите его на блок-
диаграмме в цикле между экспресс-ВП и терминалом графика осциллограм-
мы. Можно переместить терминал вправо, чтобы между экспресс-ВП и терми-
налом было больше места. Когда вы разместите экспресс-ВП на блок-диаграм-
ме, появится диалоговое окно Configure Formula (Настройка Формулы). При
размещении экспресс-ВП на блок-диаграмме, диалоговое окно настройки это-
го ВП появляется автоматически.

5. Щелкните по кнопке Help (Справка), (показана слева) в правом нижнем углу
диалогового окна Configure Formula (Настройка Формулы), чтобы отобразить
раздел справки LabVIEW для этого экспресс-ВП. Данный документ описывает
экспресс-ВП, опции диалогового окна настройки, а также вводы и выводы
экспресс-ВП.

Каждый экспресс-ВП снабжен соответствующей справочной информацией, к
которой можно обратиться, нажав на кнопку Help (Справка) в диалоговом ок-
не настройки либо вызвав контекстное меню (нажатие правой кнопкой мыши)
экспресс-ВП и выбрав пункт Help (Справка).

6. В справочном разделе Formula (Формула), найдите опцию диалогового окна,
отвечающую за ввод переменных в формулу.

7. Сверните окно LabVIEW Help, чтобы вернуться к диалоговому окну Configure
Formula (Настройка Формулы).

Начало работы с LabVIEW 7 © National Instruments Corporation

Глава 1        Начало работы с LabVIEW. Виртуальные приборы

Рисунок 1-6. Палитра Функций
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8. Измените текст в текстовом поле Label с X1 на Sawtooth, чтобы переименовать
входное значение экспресс-ВП Formula. После нажатия кнопкой мыши в текс-
товом поле String вверху диалогового окна Configure Formula, текст изменится в
соответствии с введенным названием.

9. Задайте масштабный множитель, вводя символы *10 после слова Sawtooth в
текстовом поле String.

Для этого можно использовать кнопки ввода (Input) в диалоговом окне конфи-
гурации либо клавиши *, 1, и 0 на клавиатуре. Если вы используете кнопки
Input в диалоговом окне конфигурации, LabVIEW помещает символы форму-
лы после переменной Sawtooth в текстовом поле String. При использовании
клавиатуры, щелкните левой кнопкой мыши в текстовом поле String после пе-
ременной Sawtooth и введите требуемую формулу.

Диалоговое окно Configure Formula (Настройка Формулы) должно выглядеть так
же, как на рисунке 1-7.

Примечание. При вводе неправильной формулы в текстовом поле String светодиодный индикатор
Errors (индикатор Ошибок) в правом верхнем углу станет серым и отобразит текст "Invalid Formula" (не-
верная формула).

10. Щелкните по кнопке OK, чтобы сохранить текущие настройки и закрыть ди-
алоговое окно Configure Formula.

11. Поместите курсор над стрелкой на выходе Sawtooth экспресс-ВП Simulate
Signal. 

12. Когда появится инструмент Соединения, щелкните левой кнопкой мыши по
стрелке на выходе Sawtooth и затем на входе Sawtooth эспресс-ВП Formula (по-
казано слева), чтобы соединить эти объекты.

13. Используйте инструмент Соединение для соединения выхода Result (резуль-
тат) экспресс-ВП Formula с терминалом графика осциллограммы.

Изучите проводники, соединяющие экспресс-ВП и терминалы. Стрелки в
экспресс-ВП и терминалах показывают направления потоков данных.

Блок-диаграмма должна выглядеть, как показано на рисунке 1-8. 

Подсказка: Вы можете щелкнуть правой кнопкой мыши по любому проводнику и выбрать опцию
Clean Up Wire (оптимизировать проводник) из контекстного меню, чтобы дать возможность LabVIEW
автоматически найти маршрут для проводника вокруг объектов, находящихся на блок-диаграмме.
LabVIEW прокладывает маршрут так, чтобы уменьшить количество изгибов проводника.

Рисунок 1-7. Диалоговое окно Configure Formula



Отображение двух сигналов на графике
Чтобы на одном графике сравнить сигнал, сгенерированный экспресс-ВП
Simulate Signal, с сигналом, измененным экспресс-ВП Formula, используйте
функцию Merge Signals (Объединение сигналов).

Выполните следующие шаги, чтобы отобразить два сигнала на одном графике:

1. На блок-диаграмме поместите курсор над стрелкой на выходе Sawtooth экс-
пресс-ВП Simulate Signal.

2. Используйте инструмент Катушка для соединения выхода Sawtooth с термина-
лом графика осциллограммы. 

В месте соединения двух проводников появится функция Merge Signals (Объе-
динение сигналов), показанная слева. Функция – это встроенный исполняе-
мый элемент, аналогичный операции, функции или процедуре в текстовом
языке программирования. Функция Merge Signals комбинирует два сигнала та-
ким образом, чтобы они могли отображаться на одном графике. 

Блок-диаграмма должна выглядеть, как показано на рисунке 1-9.

3. Нажмите клавиши <Ctrl-S> или выберите меню File » Save (Файл » Сохранить),
чтобы сохранить ВП.

4. Переключитесь на лицевую панель, запустите ВП и поверните ручку управления.

На графике осциллограмм отобразятся пилообразный и усиленный сигналы.
Максимальное значение по оси Y автоматически изменится, в 10 раз превы-
шая значение, задаваемое ручкой управления. Масштабирование происходит,
потому что экспресс-ВП Formula умножает сигнал на 10.

5. Щелкните по кнопке STOP, чтобы остановить ВП.
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14. Нажмите клавиши <Ctrl-S> или выберите меню File » Save (Файл » Сохранить),
чтобы сохранить ВП.

Рисунок 1-8. Блок-диаграмма ВП Получение сигнала

Рисунок 1-9. Блок-диаграмма,
демонстрирующая применение функции Merge Signals



Настройка графика осциллограммы
На графике осциллограмм отображаются два сигнала. Чтобы указать, какой из
графиков соответствует определенному сигналу, графический индикатор можно
соответственно настроить.

Выполните следующие шаги, чтобы настроить вид графика осциллограмм.

1. Поместите курсор на панель редактирования графика. Хотя на графике изоб-
ражено две кривых, на панели редактирования отображается только одна.

2. Когда появится двунаправленная стрелка, как показано на рисунке 1-11, перета-
щите границу панели редактирования так, чтобы в ней добавилась еще одна
строчка. Когда вы отпустите кнопку мыши, появится название второго графика.

Настройка ручки управления
Ручка управления изменяет амплитуду пилообразного сигнала, поэтому ярлык
"Амплитуда" точно опишет ее назначение. 

Выполните следующие шаги, чтобы настроить внешний вид ручки.

1. На лицевой панели щелкните правой кнопкой мыши по ручке и выберите оп-
цию Properties (Свойства) из контекстного меню. Появится диалоговое окно
Knob Properties (Свойства ручки управления).

2. В разделе Label (ярлык) на вкладке Appearance (внешний вид), удалите из текс-
тового поля текст Knob и введите Амплитуда. 

Диалоговое окно Knob Properties (Свойства ручки управления) должно выгля-
деть, как на рисунке 1-10. 

3. Щелкните по вкладке Scale (Шкала) и в разделе Scale Style (Тип шкалы), выде-
лите пункт Show color ramp (показать градиентную заливку).

Ручка на лицевой панели обновится в соответствии с этими изменениями.

4. Щелкните по кнопке OK, чтобы сохранить текущую конфигурацию и закрыть
диалоговое окно Knob Properties.

5. Сохраните ВП.

6. Повторно откройте диалоговое окно Knob Properties и поэкспериментируйте с
другими свойствами ручки управления. Например, на вкладке Scale попробуй-
те изменить цвет в поле Marker text color, щелкая по палитре цветов.

7. Нажмите кнопку Cancel, чтобы отменить сделанные изменения. 

Если вы хотите сохранить изменения, нажмите кнопку OK.
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Рисунок 1-10. Диалоговое окно Knob Properties



Итоги

Диалоговое окно New и Шаблоны ВП 
Диалоговое окно New содержит множество шаблонов ВП, включая и те, которые
используются в данном руководстве. Шаблоны помогают создавать ВП для наи-
более распространенных измерительных и других приложений. Они содержат
экспресс-ВП, функции и объекты лицевой панели, которые могут потребоваться
при создании указанных приложений.

Чтобы открыть диалоговое окно New, используйте один из следующих методов:

• После запустите LabVIEW щелкните по ссылкам New, VI from Template или
More в окне Getting Started.

• Выберите меню File » New (Файл » Новый) в окне Getting Started, на лицевой
панели или блок-диаграмме.

Лицевая панель
Лицевая панель – интерфейс пользователя ВП. При создании лицевой панели,
используются элементы управления и индикаторы, которые являются, соответ-
ственно, интерактивными терминалами ввода/вывода этих ВП. Элементы управ-
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3. Щелкните правой кнопкой мыши по графику осциллограмм и выберите
Properties (Свойства) из контекстного меню. Появится диалоговое окно
Waveform Graph Properties (Свойства графика осциллограмм).

4. На вкладке Plots (графики), выберите Sawtooth из выпадающего меню. В разделе
Colors (цвета) щелкните на палитру цветов линии. Выберите новый цвет линии.

5. Выберите Sawtooth (Formula Result) из выпадающего меню.

6. Выделите галочкой пункт Do not use waveform names for plot names (не использо-
вать названия осциллограмм в качестве названий кривых).

7. В текстовом поле Name, удалите текущий ярлык и измените название этого
графика на "Масштабированный пилообразный сигнал". 

8. Щелкните по кнопке OK, чтобы сохранить текущие настройки и закрыть диа-
логовое окно Waveform Graph Properties (Свойства графика осциллограмм).
Цвет графиков на лицевой панели изменится.

9. Повторно откройте диалоговое окно Waveform Graph Properties (Свойства гра-
фика осциллограмм) и поэкспериментируйте с другими свойствами графиков.
Например, на вкладке Scales попробуйте отключить автоматическое масшта-
бирование по оси Y.

10. Нажмите кнопку Cancel, чтобы отменить сделанные изменения.

Если вы хотите сохранить изменения, нажмите кнопку OK.

11. Сохраните и закройте ВП.

Рисунок 1-11. Увеличение панели редактирования



ления и индикаторы расположены в палитре элементов управления. Примерами
элементов управления являются ручки управления, кнопки, круговые шкалы и
другие элементы ввода. Они моделируют реальные устройства ввода значений и
поставляют данные на блок-диаграмму ВП.

Индикаторами являются графики, светодиодные, числовые индикаторы и др.

Индикаторы моделируют устройства вывода значений и отображают данные, ко-
торые были получены или сгенерированы на блок-диаграмме.

Блок-диаграмма
Блок-диаграмма содержит графический исходный код, также известный как код
на языке G, который описывает работу ВП. Для управления объектами лицевой
панели на блок-диаграмме используется графическое представление функций.
Объекты лицевой панели имеют на блок-диаграмме вид иконок терминалов.

Проводники (Wire) соединяют терминалы элементов управления и индикаторов с
экспресс-ВП, ВП и функциями. Данные перемещаются по проводникам от эле-
ментов управления к ВП и функциям, от ВП и функций к другим ВП и функци-
ям, и от ВП и функций к индикаторам. Перемещение данных через узлы на блок-
диаграмме определяет порядок выполнения ВП и функций.

Это движение данных известно как программирование потока данных.

Инструментальные средства
для работы с лицевой панелью и блок-диаграммой

При наведении курсора на объект лицевой панели или блок-диаграммы появляется
инструмент Позиционирования. Курсор становится стрелкой, которую можно ис-
пользовать для выделения, размещения и изменения размеров объекта. Если навес-
ти курсор на терминал объекта блок-диаграммы, появляется инструмент Соединение.
Курсор принимает вид катушки, которую можно использовать для соединения тех
объектов на блок-диаграмме, через которые должны проходить данные.

Запуск и остановка ВП
Запуск ВП возвращает решение задачи. Нажмите на кнопку Run или комбина-
цию клавиш <Ctrl-R> для запуска ВП. Кнопка Run примет вид затемненной
стрелки, чтобы показать, что данный ВП выполняется. Вы можете остановить
ВП немедленно, нажав на кнопку Abort Execution. Однако подобное прерывание
ВП, особенно, если он использует внешние ресурсы, может оставить аппаратные
средства в неизвестном состоянии.

Поэтому, во избежание данной проблемы, предусмотрите в создаваемом ВП
кнопку остановки. Кнопка Стоп останавливает ВП после окончания исполнения
текущей итерации ВП.

Экспресс-ВП
Экспресс ВП, расположенные в палитре Функций, используются для выполнения
наиболее распространенных измерительных задач. При размещении экспресс-ВП
на блок-диаграмме по умолчанию появляется диалоговое окно для настройки дан-
ного экспресс-ВП. В этом диалоговом окне можно настроить опции, задавая, та-
ким образом, поведение ВП. Для вызова диалогового окна настройки, можно
дважды щелкнуть по экспресс-ВП или щелкнуть правой кнопкой мыши по экс-
пресс-ВП и выбрать опцию Properties (Свойства) из контекстного меню. Если вы
подключите данные к экспресс-ВП и запустите его, экспресс-ВП покажет реаль-
ные данные в диалоговом окне конфигурации. Если вы закроете и повторно откро-
ете экспресс-ВП, на графике в диалоговом окне настройки будет показан образец
данных безотносительно подаваемых значений, пока вы не запустите его снова. На
блок-диаграмме экспресс-ВП имеют вид голубых иконок с расширяемыми грани-
цами. Изменяя размеры экспресс-ВП, можно отобразить все его вводы и выводы,
количество которых зависит от настройки ВП.
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Документация LabVIEW
Справка LabVIEW Help содержит информацию о концепциях программирования
в среде LabVIEW, пошаговые инструкции по использованию LabVIEW и ссылки
на дополнительную информацию о ВП, функциях, палитрах, меню, инструмен-
тальных средствах, свойствах, методах, событиях, диалоговых окнах и так далее.
В справке LabVIEW также перечислены ресурсы, доступные в компании National
Instruments. Чтобы получить справочную информацию для конкретного экс-
пресс-ВП, в диалоговом окне настройки этого ВП нажмите на кнопку Help
(Справка). Вы также можете обратиться к справке LabVIEW Help из контекстно-
го меню объекта, щелкнув по нему правой кнопкой мыши на блок-диаграмме
или прикрепленной палитре или выбрав справку Help"Search the LabVIEW Help.

После установки какого-либо дополнения к LabVIEW, например библиотеки,
модуля или драйвера документация для него появится в справке LabVIEW Help
или отдельной справочной системе, к которой можно обратиться, выбрав меню
Help » Add-On Help, где Add-On Help – название справки для дополнения.

Диалоговые окна свойств
Диалоговые окна свойств и контекстные меню используются для настройки
внешнего вида или поведения элементов управления и индикаторов.

Чтобы открыть диалоговое окно свойств конкретного объекта лицевой панели,
щелкните по нему правой кнопкой мыши и в появившемся контекстном меню
выберите опцию Properties (Свойства). Обратите внимание, что диалоговые окна
свойств нельзя открыть во время работы ВП.

"Горячие" клавиши
В этой главе использовались следующие "горячие" клавиши:

Примечание: Клавиша <Ctrl> здесь соответствует клавише <Option> или <Command> (Mac OS) или
клавише <Alt>(Linux).
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При создании нового ВП в качестве отправной точки можно использовать один
из множества шаблонов ВП LabVIEW.

Однако иногда необходимо создать такой ВП, шаблона которого нет в наличии.
В этой главе вы научитесь создавать и настраивать ВП, не пользуясь шаблонами.

Можно создать новый ВП, добавляя структуры и экспресс-ВП на блок-диаграм-
му пустого ВП. Этот способ будет продемонстрирован в следующем упражнении.

Вы создадите ВП, который сгенерирует сигнал, уменьшит в нем количество вы-
борок и отобразит результаты в таблице на лицевой панели. После того, как вы
завершите упражнение, лицевая панель ВП должна выглядеть так же, как пока-
зано на рисунке 2-1.

Выполнение этого упражнения займет у вас около 45 минут.

2
Создание ВП
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Создание ВП из пустого ВП

Открытие пустого ВП (Blank VI)
Если шаблона ВП, который вы хотите создать для выполнения конкретной задачи,
нет в наличии, то можно начать с пустого ВП и добавить в него экспресс-ВП. 

Выполните следующие шаги, чтобы открыть пустой ВП (Blank VI):

1. В окне первоначального запуска Getting Started, щелкните по ссылке Blank VI
(Пустой ВП) в разделе New (Новый) или нажмите сочетание клавиш <Ctrl-N>.

Появятся пустые окна лицевой панели и блок-диаграммы.

Примечание: Пустой ВП можно открыть также, если выбрать меню File » New VI (Файл » Новый ВП)
или File » New (Файл » Новый) и выбрать Blank VI (пустой ВП) из списка Create New (Создать новый).

2. Если палитра функций (Functions palette) не видна, щелкните правой кнопкой
мыши в любом свободном месте блок-диаграммы. Нажмите на значок "булавки",
показанный слева, в левом верхнем углу Палитры функций, чтобы закрепить па-
литру, и тогда она будет присутствовать постоянно.

Рисунок 2-1. Лицевая панель ВП Reduce Samples



Добавление экспресс-ВП, моделирующего сигнал
Выполните следующие шаги для поиска необходимого экспресс-ВП и добавле-
ния его на блок-диаграмму.

1. Выберите меню Help » Show Context Help (Помощь » Показать окно контекст-
ной справки) на лицевой панели или блок-диаграмме, чтобы отобразить окно
контекстной справки, которое показано на рисунке 2-2. Также для этого мож-
но щелкнуть по кнопке "Show Context Help Window" (Показать окно контекст-
ной справки), которая показана слева, на панели инструментов лицевой пане-
ли или блок-диаграммы. 

Подсказка: Для отображения контекстной справки вы также можете нажать клавиши <Ctrl-H>
(Mac OS) клавиши <Command-Shift-H>.
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2. В палитре Функций выберите Express » Input palette (Экспресс » палитра Ввод )
и наведите курсор на один из экспресс-ВП в палитре Input. При наведении
курсора на ВП окно Контекстной справки покажет информацию об этом ВП.

3. Используйте информацию, которая появляется в окне контекстной справки, что-
бы найти экспресс-ВП, который может моделировать синусоидальный сигнал.

Оставьте окно Контекстной справки открытым. Контекстная справка будет
снабжать вас полезной информацией, пока  вы выполняете оставшуюся часть
данного упражнения.

4. Выберите экспресс-ВП и поместите его на блок-диаграмму. На экране появится
диалоговое окно Настройка моделируемого сигнала (Configure Simulate Signal). 

5. Перемещайте курсор по различным опциям в диалоговом окне Configure
Simulate Signal (Настройка моделируемого сигнала), таким как Frequency (Час-
тота) (Гц) и Amplitude (Амплитуда). Просматривайте информацию, которая по-
является в окне контекстной справки.

6. Настройте экспресс-ВП Simulate Signal (моделирование сигнала) так, чтобы он
моделировал синусоиду с частотой 10.7 и амплитудой 2. 

Сигнал в окне "Result Preview" (Предварительный просмотр результата) изме-
нится и отобразит смоделированную синусоиду.

7. Щелкните по кнопке OK, чтобы сохранить текущие настройки и закрыть диа-
логовое окно Настройка моделируемого сигнала (Configure Simulate Signal).

8. Поместите курсор мыши над экспресс-ВП Simulate Signal и посмотрите ин-
формацию, которая появится в окне контекстной справки. Окно Контекстной
справки отобразит информацию о настройках экспресс-ВП Simulate Signal.

9. Сохраните ВП под именем Reduce Samples.vi в заранее определенном месте.

Поиск справочной информации и изменение сигнала
Выполните следующие шаги, чтобы с помощью справки LabVIEW Help найти
экспресс-ВП, уменьшающий количество выборок в сигнале.

1. Наведите курсор на экспресс-ВП Simulate Signal и щелкните по ссылке Detailed
help (Детализированная справка) в окне Контекстной справки, чтобы отобразить
раздел Simulate Signal (Моделирование Сигнала) справки LabVIEW Help. Воз-
можно, вам придется увеличить размер окна или прокрутить вниз окно Контек-
стной справки, чтобы увидеть ссылку Detailed help (Детализированная справка).

Рисунок 2-2. Окно контекстной справки
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Вы также можете обратиться к справке LabVIEW Help, щелкнув правой кноп-
кой мыши по ВП или функции на блок-диаграмме или в прикрепленной пали-
тре и выбрав пункт Help (Справка) из контекстного меню, или выбрав меню
Help » Search the LabVIEW Help (Помощь » Найти в LabVIEW Help).

2. Щелкните по вкладке Search (Поиск), введите фразу "sample compression" в
строке Type in the word(s) to search for (Введите слово для поиска) и нажмите кла-
вишу <Enter>. Чтобы найти фразу целиком, нужно взять ее в кавычки. Напри-
мер, чтобы сузить результаты поиска, введите "sample compression ". 

Эта фраза показывает, что нам необходимо от экспресс-ВП – сжатие (compres-
sion) или прореживание количества выборок в сигнале. 

3. Дважды щелкните на раздел Sample compression в результатах поиска, чтобы
отобразить раздел, который описывает экспресс-ВП Sample compression.

4. После того, как вы прочитаете описание экспресс-ВП, щелкните по кнопке
"Place on the block diagram" (Разместить на блок-диаграмме), чтобы прикрепить
экспресс-ВП к курсору.

5. Переместите курсор на блок-диаграмму.

6. Разместите экспресс-ВП Sample compression на блок-диаграмме справа от экс-
пресс-ВП Simulate Signal.

7. Настройте экспресс-ВП Sample compression так, чтобы проредить сигнал с ко-
эффициентом 25 относительно его среднего значения.

8. Щелкните по кнопке OK, чтобы сохранить текущие настройки и закрыть диа-
логовое окно Configure Sample Compression.

9. Используйте инструмент Соединение, чтобы соединить выход Sine (Синус)
экспресс-ВП Simulate Signal со входом Signals (Сигналы) экспресс-ВП Sample
compression.

Настройка интерфейса пользователя с помощью блок-диаграммы
В предыдущих упражнениях вы добавляли элементы управления (controls) и индика-
торы (indicators ) на лицевую панель, используя палитру элементов управления. Од-
нако возможно создание элементов управления и индикаторов на блок-диаграмме.

Для этого выполните следующие шаги:

1. На блок-диаграмме щелкните правой кнопкой мыши по выходу Mean (Сред-
нее) экспресс-ВП Sample compression, и выберете опцию Create » Numeric
Indicator (Создать » Числовой индикатор) из контекстного меню, чтобы создать
числовой индикатор. Числовой индикатор Mean (Среднее), который показан
слева, появится на блок-диаграмме.

2. Щелкните правой кнопкой мыши по выходу Mean (Среднее) экспресс-ВП Sample
compression и выберите опцию Insert Input/Output (Добавить ввод/вывод) из кон-
текстного меню, чтобы добавить входной терминал Enable (включить).

В предыдущем упражнении вы научились добавлять вводы и выводы, растягивая
границу экспресс-ВП с помощью стрелок. Использование контекстного меню –
другой способ сделать вводы и выводы доступными для просмотра и выбора.

3. Щелкните правой кнопкой мыши по входу Enable (включить) и выберите
пункт Create » Control (Создать » Элемент управления) из контекстного меню,
чтобы создать выключатель. Терминал логического элемента управления (по-
казан слева) появится на блок-диаграмме. 

Терминалы элементов управления имеют более широкий контур, чем терми-
налы элементов отображения. Кроме этого, стрелка на терминале элемента уп-
равления появляется справа, а на терминале индикатора – слева. 

4. Щелкните правой кнопкой мыши по проводнику, который соединяет выход
Sine (Синус) экспресс-ВП Simulate Signal со входом Signals (Сигналы) экс-
пресс-ВП Sample compression,  выберите опцию Create » Graph Indicator (Со-
здать » Графический индикатор) из контекстного меню.
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5. Используйте инструмент Соединение, чтобы соединить выход Mean (Среднее)
экспресс-ВП Sample compression с графическим индикатором Sine (Синус).
Появится Функция Merge Signals (Объединение сигналов).

6. Расположите объекты на блок-диаграмме, как показано на рисунке 2-3.

7. Переключитесь на лицевую панель.

Добавленные элементы управления (controls) и индикаторы (indicators) появи-
лись на лицевой панели и имеют ярлыки, соответствующие тем вводам и вы-
водам ВП, для которых вы их создавали.

Примечание: Возможно, вам понадобится изменить размеры лицевой панели, чтобы увидеть все эле-
менты управления и индикаторы.

8. Сохраните ВП.

Настройка ВП так,
чтобы он выполнялся непрерывно, пока пользователь его не остановит

В текущей версии ВП запускается один раз, сгенерирует сигнал и заканчивает
свое выполнение. Чтобы ВП выполнялся до определенного момента, можно ис-
пользовать цикл по условию (While Loop). 

Выполните следующие шаги, чтобы добавить Цикл по условию (While Loop) на
блок-диаграмму.

1. Активируйте лицевую панель и запустите ВП.

ВП выполнится один раз и, затем, остановится. На лицевой панели нет кноп-
ки остановки.

2. Переключитесь на блок-диаграмму.

3. Щелкните по кнопке Search (Найти), которая показана слева, на палитре Функ-
ций, и введите слово While в текстовое поле. LabVIEW ищет слова, которые вы
набрали, и отображает любые совпадения в текстовом поле результатов поиска.
В поле результатов поиска слева от названия подпалитры будет отображаться
символ папки, а в случае экспресс-ВП это будет иконка ВП на голубом фоне.

4. Дважды щелкните While Loop <<Execution Control>> (Цикл по условию<Управ-
ление выполнением>), чтобы отобразить подпалитру Execution Control и Цикл
по условию.

5. Выберите Цикл по условию в палитре Execution Control.

6. Поместите курсор мыши в верхний левый угол блок-диаграммы. Щелкните
там, чтобы "закрепить" верхний левый угол Цикла по условию.

7. Переместите курсор по диагонали так, чтобы охватить все экспресс-ВП и про-
водники, как показано на рисунке 2-4.

Рисунок 2-3. Блок-диаграмма ВП Reduce Samples
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8. Еще раз щелкните кнопкой мыши, чтобы создать Цикл по условию, охватыва-
ющий экспресс-ВП и проводники.

Цикл по условию, который показан слева, появится с кнопкой Стоп (STOP), со-
единенной с терминалом условия выхода (conditional terminal). Этот цикл будет
останавливаться при нажатии на кнопку Стоп (STOP).

9. Переключитесь на лицевую панель и выполните ВП.

ВП теперь будет выполняться до тех пор, пока вы не нажмете кнопку Стоп
(STOP).

10. Нажмите кнопку Стоп (STOP) и сохраните ВП.

Использование окна Список ошибок (Error List)
Если ВП содержит ненужные индикаторы, вы можете их удалить.

Выполните следующие шаги, чтобы удалить индикатор Mean (Среднее) с лице-
вой панели.

1. На лицевой панели поместите курсор над индикатором Mean (Среднее) и дож-
дитесь, пока появится инструмент Позиционирования (Positioning tool).

2. Щелкните по индикатору Mean (Среднее), который показан слева, выделите
его и нажмите клавишу <Delete>.

3. Переключитесь на блок-диаграмму.

Проводник теперь выглядит как черная штриховая линия с красным крести-
ком посередине (показано слева). Линия такого вида – это неисправный про-
водник. Кнопка Пуск (Run) принимает вид сломанной стрелки (показана сле-
ва), чтобы указать, что этот ВП нельзя запустить.

4. Щелкните по неисправной кнопке Пуск (Run), чтобы вывести на экран окно
Error list (Список ошибок), в котором перечислены все допущенные ошибки в
ВП и сообщена детальная информация о каждой ошибке. Кроме этого, окно
Error list (Список ошибок) можно использовать, чтобы определить местона-
хождение ошибки.

5. В списке Errors and warnings (Ошибки и предупреждения), выберите пункт
Wire: has loose ends (Провод: имеет свободный конец) и щелкните по кнопке
Help (Справка), чтобы вывести на экран подробную информацию об ошибке.

Подсказка: Чтобы вывести на экран подсказку с описанием неисправности, вы можете поместить ин-
струмент Соединение ("катушка") на неисправный проводник. Эта информация также появляется в ок-
не контекстной справки.

6. В списке Errors and warnings (Ошибки и предупреждения), дважды щелкните по
пункту Wire: has loose ends (Провод: имеет свободный конец), чтобы выделить
неисправный проводник.

Рисунок 2-4. Размещение экспресс-ВП внутри Цикла по условию



7. Нажмите сочетание клавиш <Ctrl-B>, чтобы его удалить.

Нажатием клавиш <Ctrl-B> стираются все неисправные проводники на блок-
диаграмме. Чтобы стереть только выделенный проводник, нажмите клавишу
<Delete>.

8. Выберите View » Error List (Показать » Список ошибок), чтобы вывести на эк-
ран окно списка ошибок. Теперь список пуст.

Подсказка: Также, для того, чтобы вывести на экран окно списка ошибок, можно нажать сочетание
клавиш <Ctrl-L>.

9. Нажмите на кнопку Close, чтобы закрыть окно списка ошибок. Кнопка Run те-
перь будет работоспособна.

Управление скоростью выполнения
Чтобы строить точки на графике осциллограмм более медленно, можно добавить
на блок-диаграмму временную задержку.

Выполните следующие шаги, чтобы иметь возможность управлять скоростью вы-
полнения ВП.

1. В палитре Функций на блок-диаграмме найдите экспресс-ВП Time Delay (вре-
менная задержка) и поместите его в Цикл по условию. Он предназначен для уп-
равления скоростью выполнения ВП.

2. Введите значение 0.25 в текстовое поле Time delay (Время задержки) (секунды).
Это значение определяет, как часто будет выполняться цикл. Если время за-
держки равно 0.25 секунды, цикл будет выполнять итерацию раз в четверть се-
кунды.

3. Щелкните кнопкой OK, чтобы сохранить текущие настройки и закрыть диало-
говое окно Configure Time Delay (Настроить временную задержку).

4. Переключитесь на лицевую панель и запустите ВП.

5. Переключите элемент управления Enable и изучите изменения на графике. Ес-
ли переключатель включен, график будет отображать прореженный сигнал. 

6. Нажмите кнопку STOP (Стоп), чтобы остановить ВП.

Использование таблиц для вывода данных на экран
Выполните следующие шаги, чтобы вывести на экран набор средних значений в
таблице на лицевой панели.

1. В палитре элементов управления (Controls palette) на лицевой панели найдите
индикатор Express Table и поместите его на лицевую панель, справа от графика
осциллограмм.

2. Переключитесь на блок-диаграмму.

LabVIEW автоматически соединил терминал Table (Таблица) с экспресс-ВП
Build Table (построение таблиц).

3. Если экспресс-ВП Build Table и терминал Table (Таблица) еще не выделены,
щелкните по свободному месту блок-диаграммы слева от экспресс-ВП Build
Table и терминала Table (Таблица). Переместите курсор по диагонали, пока пря-
моугольник области выделения не охватит их, как показано слева. 

При этом экспресс-ВП Build Table, терминал Table (Таблица) и проводник меж-
ду ними будут охвачены двигающимся пунктирным контуром.

4. Переместите эти объекты в Цикл по условию, справа от экспресс-ВП Sample
Compression.

Если вы переместите объекты около границы Цикла по условию, цикл изменит
размеры, чтобы включить в себя экспресс-ВП Build Table и терминал Таблицы. 
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При размещении объекта около границы цикла, цикл изменяет размеры, что-
бы добавить место для этого объекта.

5. Используйте инструмент Соединение ("катушка"), чтобы присоединить выход
Mean (Среднее) экспресс-ВП Sample Compression к входу Signals (Сигналы) экс-
пресс-ВП Build Table. Блок-диаграмма должна выглядеть, как показано на ри-
сунке 2-5.

6. Переключитесь на лицевую панель и запустите ВП.

7. Щелкните переключателем Enable.

Если переключатель Enable включен, таблица будет отображать средние значе-
ния каждых 25 выборок синусоиды. Если он выключен, таблица не будет запи-
сывать средние значения.

8. Остановите ВП.

9. Поэкспериментируйте со свойствами таблицы, используя диалоговое окно
Table Properties (Свойства таблицы). Например, попробуйте изменить число
столбцов до одного.

10. Сохраните и закройте ВП.

Поиск примеров
Для того чтобы больше узнать о том, как можно использовать определенный ВП,
вы можете найти и рассмотреть пример, в котором этот ВП используется.

Выполните следующие шаги, чтобы найти и открыть пример, который использу-
ет экспресс-ВП Time Delay (Временная задержка).

1. Выберите меню Help » Search the LabVIEW Help (Справка » Поиск в справке
LabVIEW), чтобы вывести на экран справку LabVIEW Help .

2. Щелкните по вкладке Search, введите "time delay"(временная задержка) в текс-
товое поле Type in the word(s) to search for (Введите слова для поиска), и нажми-
те клавишу <Enter>.

Подсказка: Прежде, чем искать, можно сузить область поиска, поставив галочку Search titles only (ис-
кать только в заголовках) снизу в окне справки. Также можно использовать операторы, такие как AND
(И), OR (ИЛИ), и NEAR (Почти) в текстовом поле Type in the word(s) to search for. Для получения допол-
нительной информации о поиске, обратитесь к книге Using Help (Использование Справки) во вкладке
Contents (Содержание) справки LabVIEW Help. 

3. Щелкните по заголовку столбца Location (Расположение), чтобы отсортиро-
вать результаты поиска по содержанию. Разделы Reference (справочной инфор-
мации) содержат базовую информацию об объектах LabVIEW, таких как ВП,
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Рисунок 2-5. Блок-диаграмма ВП Reduce Samples



функций, палитры, меню, инструменты. Разделы How-To (практические реко-
мендации) содержат пошаговые инструкции, как пользоваться LabVIEW. Раз-
делы Concept (Концепции) содержат информацию о концепциях программи-
рования в LabVIEW.

4. Дважды щелкните по результату поиска Time Delay (Время задержки), чтобы
вывести на экран раздел справки, описывающий экспресс-ВП Time Delay.

5. После того, как вы прочитаете описание экспресс-ВП, нажмите кнопку Open
example (Открыть пример) в разделе Example (Пример) внизу раздела, чтобы от-
крыть пример, который использует экспресс-ВП Time Delay.

6. Щелкните по кнопке Browse related examples (Просмотреть похожие примеры),
чтобы открыть NI Example Finder (Поисковик примеров) и вывести на экран
список примеров, в которых используется этот ВП. Поисковик осуществляет
поиск среди сотен примеров, включая все установленные на компьютер при-
меры, а также примеры из ресурса NI Developer Zone на сайте ni.com/zone.
Вы можете скорректировать пример под необходимое приложение или скопи-
ровать и вставить один или более примеров в ВП, который создаете. Вы также
можете щелкнуть правой кнопкой мыши по ВП или функции на блок-диа-
грамме или на прикрепленной палитре и выбрать Examples (Примеры) из кон-
текстного меню, чтобы вывести на экран раздел справки со ссылками на при-
меры для этого ВП или функции.

Запустите Поисковик примеров NI и просмотрите или поищите примеры, вы-
брав меню  Help » Find Examples (Справка » Найти примеры) или щелкнув по
ссылке Find Examples (Найти примеры) в разделе Examples (Примеры) окна
Getting Started.

7. После того, как вы поэкспериментируете с Поисковиком примеров NI и приме-
рами ВП, закройте их.

Итоги

Использование встроенной справки LabVIEW
В этой главе вы научились пользоваться различными средствами справочной си-
стемы LabVIEW:

• окно Context Help (Контекстная справка) показывает основную информацию
об объекте LabVIEW, когда вы наводите курсор на этот объект. Объекты с кон-
текстной справочной информацией включают ВП, функции, структуры, палитры,
компоненты диалогового окна, и так далее. Чтобы вызвать окно контекстной
справки, выберите меню Help » Show Context Help (Справка » Показать контекст-
ную справку) или нажмите сочетание клавиш <Ctrl-H>(Mac OS). Нажмите клави-
ши <Command-Shift-H>.

• Когда вы помещаете курсор на экспресс-ВП на блок-диаграмме, окно Контек-
стной справки отображает краткое описание экспресс-ВП и информацию о его
настройках.

• Справка LabVIEW Help содержит подробную информацию об объектах
LabVIEW. Чтобы обратиться к разделу LabVIEW Help для конкретного объекта,
наведите курсор на этот объект и щелкните по ссылке Detailed help (Детализи-
рованная справка) в окне Context Help (Контекстная справка). Вы также може-
те щелкнуть правой кнопкой мыши по объекту на блок-диаграмме или на при-
крепленной палитре и выбрать опцию Help (Справка) из контекстного меню.

• Чтобы перемещаться по справке LabVIEW Help, используйте вкладки Contents
(Содержание), Index (Указатели) и Search (Поиск). Используйте вкладку
Contents (Содержание), чтобы просмотреть разделы и структуру справки.
Вкладка Index (Указатели) используется для нахождения раздела по ключевому
слову, а вкладка Search (Поиск) для поиска слова или фразы.
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• Если в справке LabVIEW Help вы нашли объект, который хотите использовать,
нажмите кнопку Place on the block diagram, чтобы поместить объект на блок-
диаграмму.

• Во вкладке Search справки LabVIEW Help, используйте операторы, такие как
AND (И), OR (ИЛИ), и NEAR (Почти), чтобы сузить результаты поиска. Что-
бы искать точную фразу, возьмите ее в кавычки. Прежде, чем искать, вы може-
те сузить результаты поиска, поставив галочку Search titles only снизу в окне
справки.

• Во вкладке Search вы можете щелкнуть по заголовку столбца Location над спи-
ском результатов поиска, чтобы отсортировать результаты по видам информа-
ции (содержанию). 

Разделы Reference (справочной информации) содержат базовую информацию
об объектах LabVIEW, таких как ВП, функции, палитры, меню, инструменты.
Разделы How-To (практические рекомендации) содержат пошаговые инструк-
ции по пользованию LabVIEW. Разделы Concept (Концепции) содержат ин-
формацию о концепциях программирования в среде LabVIEW.

Редактирование кода блок-диаграммы
Для создания ВП могут использоваться различные элементы управления (con-
trols) и индикаторы (indicators), экспресс-ВП и структуры. Например, с помощью
них можно так настроить ВП, чтобы он, после нажатия на кнопку Стоп, остано-
вился и вывел на экран сгенерированные данные в виде таблицы.

Создание элементов управления и индикаторов
Элементы управления и индикаторы можно создать на блок-диаграмме, щелкая
правой кнопкой мыши по входу/выходу экспресс-ВП или проводнику и выбирая
доступные опции в разделе Create (Создать) контекстного меню. LabVIEW при-
соединит созданный элемент управления/индикатор к входу/выходу или провод-
нику, контекстное меню которого вы вызывали. Терминалы элементов управле-
ния имеют более широкий контур, чем терминалы индикаторов. Кроме этого, на
терминалах элементов управления стрелка появляется справа, а на терминалах
индикаторов – слева.

Управление остановкой выполнения ВП
Используйте Цикл по условию, чтобы непрерывно выполнять код, находящийся в
пределах цикла. Цикл по условию прекращает выполняться, когда выполняется ус-
ловие остановки. При размещении или перемещении объекта около границы Цикла
по условию цикл изменяет размеры, чтобы добавить место для этого объекта.

Палитра элементов управления Execution Control содержит объекты, которые мо-
гут использоваться для управления количеством итераций ВП, а так же скоро-
стью, с которой выполняется ВП.

Ошибки и обрывы проводников
Кнопка Run принимает вид сломанной стрелки, когда создаваемый или редакти-
руемый ВП содержит ошибки. Если кнопка Run неработоспособна и после того,
как вы закончили соединять элементы на блок-диаграмме, тогда этот ВП выпол-
ниться не сможет. Нажмите на кнопку Run или выберите View"Error List (Вид
"Список ошибок), чтобы узнать, почему ВП неработоспособен. Список ошибок
также поможет определить их местонахождение. Нажмите кнопку Help (Справ-
ка) для получения дополнительной информации об ошибке. Дважды щелкните
по ошибке в поле errors and warnings (ошибки и предупреждения), чтобы выде-
лить объект, вызвавший ошибку.

Неисправность проводника выглядит, как черная пунктирная линия с красным
значком X посередине. Неисправности происходят по различным причинам, на-
пример, если вы удаляете соединенные объекты. Обратите внимание, что ВП не
может выполниться, если его блок-диаграмма содержит неисправные проводники.
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Наведите инструмент Соединение на неисправный проводник, чтобы вывести на
экран подсказку с описанием неисправности. Эта информация также появляется
в окне контекстной справки, когда вы проводите инструментом Соединения по
неисправному проводнику. Щелкните правой кнопкой мыши по проводнику и
выберите List Errors (Список ошибок) из контекстного меню, чтобы вывести ок-
но Error list на экран.

Нажмите кнопку Help (Справка) для получения дополнительной информации о
том, почему проводник неисправен.

Представление данных в виде таблиц
Элемент отображения "Таблица" выводит на экран смоделированные данные.
Используйте экспресс-ВП Build Table, чтобы создать таблицу данных.

Использование NI Example Finder (Поисковик примеров)
Используйте поисковик примеров NI Example Finder, чтобы просмотреть или
найти примеры на вашем компьютере или в ресурсе NI Developer Zone на сайте
ni.com/zone. Эти примеры демонстрируют, как использовать LabVIEW для вы-
полнения разнообразных задач тестирования, измерения, управления и проекти-
рования. Выберите меню Help"Find Examples (Помощь"Найти примеры) или
щелкните по ссылке Find Examples (Найти примеры) в разделе Examples (Приме-
ры) окна Getting Started, чтобы запустить NI Example Finder. 

Примеры могут продемонстрировать использование определенных ВП или
функций. С этой целью вы можете щелкнуть правой кнопкой мыши по ВП или
функции на блок-диаграмме или прикрепленной палитре и выбрать опцию
Examples (Примеры) из контекстного меню. После этого появится раздел справ-
ки со ссылками на примеры для данного ВП или функции. Вы всегда сможете из-
менить пример ВП, чтобы приспособить его к вашему приложению, либо скопи-
ровать и вставить один или более примеров в создаваемый ВП.

"Горячие" клавиши
В этой главе использовались следующие "горячие" клавиши:

Примечание: Клавиша <Ctrl> здесь соответствует клавише (Mac OS) <Опция> или <Команда> или
(Linux) <Alt>.
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Среда LabVIEW содержит набор экспресс-ВП, предназначенных для анализа
сигналов. В этой главе вы научитесь использовать LabVIEW для проведения стан-
дартного анализа сигнала и сохранения результатов в файл.

Примечание: Примеры из этой главы используют экспресс-ВП, которые доступны только в полной и
профессиональной версиях среды LabVIEW (Full and Professional Development Systems)

3
Анализ и сохранение сигнала

В следующем упражнении мы создадим ВП, который генерирует сигнал,
фильтрует его, показывает, превышает ли сигнал определенный предел, и
сохраняет данные. После того, как вы завершите упражнение, лицевая панель
виртуального прибора должна выглядеть так же, как показано на рисунке 3-1.

Выполнение этого упражнения займет у вас около 40 минут.

Изменение ВП, созданного из шаблона
Выполните следующие шаги для создания ВП, который генерирует сигнал, ана-
лизирует его и выводит на экран.

1. В окне Getting Started, нажмите New, чтобы появилось диалоговое окно New.

2. Из списка Create New, выберите пункты VI » From Template » Tutorial (Getting
Started) » Generate, Analyze, and Display. Этот шаблон ВП моделирует сигнал и
анализирует его СКО (среднеквадратическое отклонение) (RMS). 

3. Нажмите кнопку OK или дважды щелкните по названию шаблона, чтобы со-
здать ВП из шаблона.

4. Если окно Context Help (Контекстной справки) закрыто, нажмите сочетание
клавиш <Ctrl-H>. (Mac OS) Нажмите клавиши <Command-Shift-H>.

5. Переключитесь на блок-диаграмму, нажав клавиши <Ctrl-E>.

6. Поместите курсор мыши над экспресс-ВП Amplitude and Level Measurements,
показанным слева. Окно Контекстной справки будет содержать информацию о
характеристиках этого ВП.

Создание ВП для анализа сигналов

Рисунок 3-1. Лицевая панель ВП Save Data



Оставьте окно Контекстной справки открытым. Оно будет снабжать вас полез-
ной информацией во время выполнения оставшейся части упражнения.

7. На лицевой панели удалите индикатор RMS (СКО), а так же некоторые неис-
правные проводники на блок-диаграмме, которые появились из-за выполне-
ния этой операции. Чтобы удалить все неисправные проводники на блок-диа-
грамме, нужно нажать сочетание клавиш <Ctrl-B>.

В этом упражнении мы не будем вычислять СКО (RMS) с помощью экспресс-ВП
Amplitude and Level Measurements. Однако вы можете использовать шаблон ВП
Generate, Analyze, and Display с возможностью вычисления среднеквадратическо-
го отклонения в следующем проекте, чтобы уменьшить время его разработки.

8. На лицевой панели щелкните правой кнопкой мыши по графику осцилло-
грамм и выберите опцию Properties (Свойства) из контекстного меню. На экра-
не появится диалоговое окно Graph Properties. 

9. На вкладке Appearance отметьте галочкой пункт Visible в разделе Label (Ярлык)
и введите Unfiltered Signal (необработанный сигнал) в текстовое поле.

10. Нажмите кнопку OK, чтобы сохранить настройки и закрыть диалоговое окно
Graph Properties.

11. Запустите ВП.

Сигнал появится на графике.

12. Нажмите кнопку STOP, чтобы остановить ВП.

Добавление сигнала
По умолчанию экспресс-ВП Simulate Signal моделирует синусоиду. 

Изменяя опции в диалоговом окне Configure Simulate Signal, можно настроить
моделируемый сигнал.

Выполните следующие шаги для создания дополнительного моделируемого сиг-
нала, который добавит к синусоиде однородный белый шум.

1. На блок-диаграмме, с помощью инструмента Перемещение ("стрелка"), выде-
лите экспресс-ВП Simulate Signal. Чтобы создать еще один экспресс-ВП
Simulate Signal, перемещайте его, одновременно удерживая клавишу<Ctrl>
(Mac OS). При перемещении удерживайте клавишу <Option> (Linux). При пе-
ремещении удерживайте среднюю кнопку мыши.

2. Поместите копию экспресс-ВП Simulate Signal под оригиналом и отпустите
кнопку мыши. Среда LabVIEW заменит имя скопированного экспресс-ВП
Simulate Signal на Simulate Signal2.

3. Дважды щелкните по экспресс-ВП Simulate Signal2, чтобы появилось диалого-
вое окно настройки Configure Simulate Signal.

4. Выберите Sine (Синус) из выпадающего меню Signal type (Тип сигнала).

5. В текстовом поле Frequency (Hz) введите значение 60.

6. В текстовом поле Amplitude введите значение 0.1.

7. Пометьте пункт Add noise, чтобы добавить шум к синусоиде.

8. Выберите пункт Uniform White Noise (Однородный белый шум) из выпадающего
меню Noise type (Тип шума).

9. В текстовом поле Noise amplitude (амплитуда шума) введите значение 0.1.

10. В текстовом поле Seed number введите значение -1.

11. В разделе Timing (Синхронизация), выберите опцию Run as fast as possible (Вы-
полняться максимально быстро).

12. В разделе Signal Name (Название сигнала), удалите отметку с пункта Use signal
type name.

13. В текстовом поле Signal name введите 60 Hz and Noise. 
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При изменении названия сигнала в окне Configure Simulate Signal среда
LabVIEW меняет название выходного терминала, что облегчает идентифика-
цию типа сигнала при просмотре экспресс-ВП на блок-диаграмме.

Раздел Result Preview (Предварительный просмотра результата) отображает
случайный сигнал. Диалоговое окно Configure Simulate Signal (настройка мо-
делируемого сигнала) должно выглядеть так же, как на рисунке 3-2.
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Рисунок 3-2. Диалоговое окно Configure Simulate Signal

14. Нажмите кнопку OK, чтобы сохранить текущие настройки и закрыть диало-
говое окно Configure Simulate Signal.

Сложение двух сигналов
Чтобы создать один сигнал, как сумму двух других, можно воспользоваться экс-
пресс-ВП Formula (Формула). В частности мы будем использовать экспресс-ВП
Formula для добавления шума к сигналу. 

Выполните следующие шаги, чтобы добавить сигнал 60 Hz and Noise к сигналу Sine.

1. На блок-диаграмме, трижды щелкните по проводнику, соединяющий выход
Sine (синус) экспресс-ВП Simulate Signal, вход экспресс-ВП Amplitude and Level
Measurements и индикатор Unfiltered Signal, и удалите этот проводник.

2. Нажмите кнопку Search (поиск) в палитре функций, чтобы найти экспресс-ВП
Formula и поместите его на блок-диаграмму между экспресс-ВП Simulate Signal
и экспресс-ВП Amplitude and Level Measurements.

3. В появившемся диалоговом окне Configure Formula в столбце Label измените
ярлык для входа X1 на Sine, а для X2 на 60 Hz and Noise.

4. Нажмите кнопки Input и "+", чтобы сложить Sine и 60 Hz and Noise, записав эту
операцию в текстовом поле String.

5. Нажмите кнопку OK, чтобы сохранить текущие настройки и закрыть диалого-
вое окно Configure Formula.

6. Используйте инструмент Соединение ("катушка"), чтобы соединить выход Sine
экспресс-ВП Simulate Signal с входом Sine экспресс-ВП Formula.

7. Соедините выход 60 Hz and Noise экспресс-ВП Simulate Signal2 с входом 60 Hz
and Noise экспресс-ВП Formula.

8. Соедините выход Result (результат) экспресс-ВП Formula с индикатором
Unfiltered Signal и входом Signals экспресс-ВП Amplitude and Level Measurements.
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Фильтрация Сигнала
Для обработки сигналов с помощью фильтров и окон, можно использовать экс-
пресс-ВП Filter (фильтр).

Выполните следующие шаги, чтобы настроить экспресс-ВП Filter так, чтобы он
производил обработку сигнала с помощью IIR (БИХ – с бесконечной импульс-
ной характеристикой) фильтра.

1. Удалите проводник, который соединяет выход Result (результат) экспресс-ВП
Formula с входом Signals экспресс-ВП Amplitude and Level Measurements.

2. Удалите все несправные проводники, которые остались после удаления.

3. Найдите экспресс-ВП Filter и поместите его на блок-диаграмму между экс-
пресс-ВП Simulate Signal2 I и экспресс-ВП Amplitude and Level Measurements. На
экране появится диалоговое окно Configure Filter.

4. В разделе Filter Specifications (Характеристики фильтра), измените Cutoff
Frequency (частота среза) (Гц) на 25.

5. Нажмите кнопку OK, чтобы сохранить настройки и закрыть диалоговое окно
Configure Filter.

6. Переключитесь на лицевую панель.

7. На лицевой панели щелкните по индикатору Unfiltered Signal, и, удерживая на-
жатой клавишу <Ctrl>, переместите его, чтобы создать ещё один график осцил-
лограмм.

8. Поместите созданный график осциллограмм под исходным.

9. Трижды щелкните по ярлыку Unfiltered Signal2 выше нового графика осцилло-
грамм и введите Filtered Signal. Также можно изменить ярлык на вкладке
Appearance (вид) диалогового окна Graph Properties.

10. На блок-диаграмме соедините выход Result (результат) экспресс-ВП Formula
с входом Signal (сигнал) экспресс-ВП Filter.

11. Соедините выход Filtered Signal экспресс-ВП Filter с входом Signal экспресс-ВП
Amplitude and Level Measurements и с терминалом графика осциллограмм
Filtered Signal.

12. Выберите меню File » Save (Файл » Сохранить). 

Блок-диаграмма ВП Analysis должна выглядеть так, как показано на рисунке 3-3.

Рисунок 3-3. Блок-диаграмма ВП Analysis

9. Переключитесь на лицевую панель, нажав клавиши <Ctrl-E>.

10. Запустите ВП.

На графике появится сигнал с добавленным шумом.

11. Нажмите кнопку STOP, чтобы остановить ВП.

12. Выберите меню File » Save As (Файл » Сохранить как) и сохраните ВП как
Analysis.vi в заранее определенном месте.
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Изменение вида графиков
Вы можете использовать страницу Format and Precision (Формат и погрешности)
диалогового окна Graph Properties, чтобы задать, в каком масштабе шкалы X и Y
появятся на графике.

Выполните следующие шаги, чтобы изменить формат шкал X и Y для графиков
Unfiltered Signal и Filtered Signal.

1. На лицевой панели, щелкните правой кнопкой мыши по графику Unfiltered
Signal и выберите пункт Properties (свойства) из контекстного меню. На экране
появится диалоговое окно Graph Properties.

2. На вкладке Format and Precision выберите Time (время) (Ось X) над выпадаю-
щим меню.

3. В списке Type (тип) выберите Automatic formatting (автоформатирование).

4. В поле Digits введите 6 и выберите пункт Significant digits (значащие цифры) из
выпадающего меню Precision Type (Тип Точности).

5. Отметьте пункт Hide trailing zeros (Скрыть лишние нули).

6. Выберите пункт Amplitude (Амплитуда) (Ось Y) над выпадающим меню и по-
вторите шаги 3-5. Теперь настройки оси Y соответствуют оси X.

7. На вкладке Scales (Масштаб), выберите пункт Amplitude (Амплитуда) (Ось Y).

8. Удалите отметку с пункта Autoscale.

9. В текстовое поле Minimum введите значение -2.5, в Maximum - значение 2.5.

10. Нажмите кнопку OK, чтобы сохранить настройки и закрыть диалоговое окно
Graph Properties.

11. Повторите шаги 1-10, чтобы настроить вид графика Filtered Signal. 

Оси X и Y на графиках Unfiltered Signal и Filtered Signal изменятся, отражая
сделанные изменения.

Анализ амплитуды сигнала
Для анализа изменения сигнала можно использовать экспресс-ВП Amplitude and
Level Measurements.

Выполните следующие шаги, чтобы настроить экспресс-ВП для измерения
амплитуды сигнала.

1. На блок-диаграмме, дважды щелкните по экспресс-ВП Amplitude and Level
Measurements, чтобы появилось диалоговое окно Configure Amplitude and Level
Measurements.

2. В разделе Amplitude Measurements (Измерение амплитуды), удалите отметку с
пункта RMS (СКО).

3. Отметьте пункт Peak to peak. Peak to peak появится в разделе Results
(Результаты) с соответствующим измеренным значением. 

4. Нажмите кнопку OK, чтобы сохранить текущие настройки и закрыть
диалоговое окно Configure Amplitude and Level Measurements. Выход RMS
экспресс-ВП Amplitude and Level Measurements изменится на выход Peak to peak,
как показано слева. Мы будем использовать выход Peak to peak позже.
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Добавление предупредительной световой сигнализации
Если вы хотите иметь индикацию события, заключающегося в превышении сиг-
налом определенного значения, можно использовать световую сигнализацию.

Выполните следующие шаги, чтобы добавить в ВП световую сигнализацию.

1. Щелкнув правой кнопкой мыши на любом свободном месте лицевой панели,
вызовите палитру элементов управления. 

2. В подпалитре Express, выберите подпалитру светодиодных индикаторов, кото-
рая показана на рисунке 3-4.

3. Выберите круглый светодиодный индикатор и поместите его на лицевую па-
нель слева от графиков.

4. Дважды щелкните по ярлыку Boolean над индикатором и измените его на
Warning (Предупреждение). Мы будем использовать этот светодиодный инди-
катор позже, чтобы показать, когда значение превысило свой предел.

5. Выберите меню File » Save (Файл » Сохранить как), чтобы появилось диалого-
вое окно Save As.

6. Просмотрите различные опции этого диалогового окна. Выберите опцию Copy
(Копировать) и выделите пункт Substitute copy for original, чтобы создать копию
исходного ВП и начать ее редактировать.

7. Нажмите кнопку Continue и сохраните ВП как Warning Light.vi в зара-
нее определенном месте.

Управление скоростью выполнения
Чтобы точки на графике появлялись медленнее, необходимо добавить задержку
на блок-диаграмму.

Выполните следующие шаги, чтобы управлять скоростью, с которой выполняет-
ся ВП.

1. Найдите экспресс-ВП Time Delay (Временная задержка).

2. Поместите его в нижний левый угол Цикла по условию. На экране появится ди-
алоговое окно Configure Time Delay.

3. В текстовое поле Time delay (seconds) введите значение .1 и нажмите кнопку
OK.

4. Запустите ВП.

Цикл будет выполняться с частотой 10 итераций в секунду.

Рисунок 3-4. Палитра светодиодных индикаторов

Настройка предельного значения
Чтобы определить значение, при котором светодиодный индикатор будет вклю-
чаться, используйте экспресс-ВП Comparison (Сравнение).

Выполните следующие шаги, чтобы сравнить значение удвоенной амплитуды с
задаваемым пределом.
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2. Соедините выход Result (Результат) экспресс-ВП Greater с терминалом
Warning. Блок-диаграмма должна выглядеть, как показано на рисунке 3-5.

1. Найдите экспресс-ВП Comparison и поместите его справа от экспресс-ВП
Amplitude and Level Measurements. На экране появится диалоговое окно
Configure Comparison.

2. В разделе Compare Condition (Условия сравнения) выберите опцию Greater(>)
(Больше).

3. В разделе Comparison Inputs выберите Value и введите 2 в текстовое поле Value,
чтобы задать постоянное значение, при котором светодиод будет гореть.

4. Нажмите кнопку OK, чтобы сохранить текущие настройки и закрыть диалого-
вое окно Configure Comparison.

Название экспресс-ВП Comparison изменится, отражая выполняемую опера-
цию, как показано слева. Название Greater (Больше) указывает, что экспресс-
ВП выполняет сравнение "больше?".

5. Соедините выход Peak to Peak экспресс-ВП Amplitude and Level Measurements с
входом Operand 1 экспресс-ВП Greater.

6. Наведите курсор на проводник, который соединяет выход Peak to Peak к входу
Operand 1.

7. Когда появится инструмент Перемещение, щелкните правой кнопкой мыши
по проводнику и выберите Create » Numeric Indicator (Создать » Числовой Ин-
дикатор) из контекстного меню.

Терминал Peak to Peak, который показан слева, появится на блок-диаграмме.

Если терминал Peak to Peak появится на проводниках между экспресс-ВП, пере-
двиньте экспресс-ВП и терминал Peak to Peak, создавая больше места. Например,
переместите терминал Peak to Peak на свободное место выше экспресс-ВП.

Предупреждение пользователя
После задания значения, при котором светодиод будет загораться, необходимо
соединить светодиодный индикатор с экспресс-ВП Greater.

Выполните следующие шаги, чтобы создать визуальную индикацию, когда раз-
мах сигнала превысит заданный предел.

1. На блок-диаграмме поместите терминал Warning (Предупреждение) справа от
экспресс-ВП Greater. Удостоверьтесь, что этот терминал находится в Цикле по
условию, как показано на рисунке 3-5.

Рисунок 3-5. Блок-диаграмма ВП Warning Light 
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3. Переключитесь на лицевую панель.

На ней появится числовой индикатор с ярлыком Peak to Peak. Этот индикатор
отображает значение двойной амплитуды сигнала.

4. Запустите ВП.

Когда значение двойной амплитуды превысит 2.0, индикатор Warning загорается.

5. Нажмите кнопку STOP, чтобы остановить ВП.

6. Сохраните ВП.

Настройка ВП для сохранения данных в файл
Чтобы сохранить информацию о данных, которые моделирует ВП, используйте
экспресс-ВП Write To Measurement File.

Выполните следующие шаги для создания ВП, который сохраняет значения амп-
литуды размаха и другую информацию в файл данных LabVIEW.

1. Найдите экспресс-ВП Write To Measurement File и поместите его на блок-диа-
грамму ниже и правее экспресс-ВП Amplitude and Level Measurements. На экра-
не появится диалоговое окно настройки Write To Measurement File.

Текстовое поле File Name содержит полный путь к выходному файлу test.lvm.
Файл . lvm – текстовая таблица измерений со столбцами, разделеными сим-
волом табуляции, который можно открыть с помощью приложений для просмот-
ра и редактирования электронных таблиц или текстовых файлов. Среда LabVIEW
сохраняет данные с шестью разрядами точности. По умолчанию файл сохранится
в папке LabVIEW Data. Среда LabVIEW располагает папку LabVIEW Data в задан-
ном по умолчанию каталоге файлов операционной системы.

Если вы хотите просмотреть данные, используйте путь к файлу, отображенный
в текстовом поле File Name.

2. В разделе If a file already exists (Если файл уже существует) диалогового окна
Configure Write To Measurement File выберите опцию Append to file, чтобы допи-
сать все данные в файл test.lvm, не стирая уже существующие.

3. В разделе Segment Headers (Заголовки Сегмента) выберите опцию One header
only, чтобы создать только один заголовок файлу, в который LabVIEW записы-
вает данные.

4. В текстовое поле File Description введите следующий текст: Sample of peak to
peak values (Пример значений размаха сигнала). LabVIEW прикрепит этот текст
к заголовку файла.

5. Нажмите кнопку OK, чтобы сохранить текущие настройки и закрыть диалого-
вое окно Configure Write To Measurement File.

Сохранение данных в файл
После завершения работы ВП, среда LabVIEW сохранит данные в файл test.lvm.

Выполните следующие шаги, чтобы создать файл test.lvm.

1. На блок-диаграмме соедините выход Peak to Peak экспресс-ВП Amplitude and
Level Measurements с входом Signals (Сигналы) экспресс-ВП Write To
Measurement File.

2. Выберите File » Save (Файл » Сохранить как) и сохраните ВП, как Save
Data.vi в заранее определенном месте.

3. Переключитесь на лицевую панель и запустите ВП.

4. Нажмите кнопку STOP на лицевой панели.

5. Чтобы просмотреть данные, которые вы сохранили, откройте файл test.lvm
в папке LabVIEW Data с помощью любого текстового редактора. Файл будет
иметь заголовок, содержащий информацию об экспресс-ВП.

6. Закройте файл после просмотра и вернитесь к ВП Save Data.



Добавление кнопки, при нажатии которой данные будут сохраняться 
Если вы хотите сохранить только определенные значения данных, вы можете на-
строить экспресс-ВП Write To Measurement File так, чтобы значения амплитуды
размаха сохранялись только тогда, когда пользователь нажимает кнопку.

Выполните следующие шаги, чтобы добавить кнопку в ВП и настроить её пове-
дение при нажатии.

1. Найдите в палитре элементов управления тумблер и поместите его справа от
графиков.

2. Щелкните правой кнопкой мыши по кнопке и выберите опцию Properties
(Свойства) из контекстного меню, чтобы отобразить диалоговое окно свойств.

3. Измените ярлык кнопки на Write to File.

4. На вкладке Operation (Функционирование) диалогового окна Boolean Properties,
выберите режим Latch when pressed из меню Button behavior (Режим работы). Это
меню используется для задания поведения кнопки при нажатии. Увидеть, как
кнопка реагирует на щелчок, можно в разделе Preview Selected Behavior.

5. Нажмите кнопку OK, чтобы сохранить текущие настройки и закрыть диалого-
вое окно Boolean Properties.

6. Сохраните ВП.

Сохранение данных по запросу пользователя
Выполните следующие шаги, чтобы создать ВП, который регистрирует данные в
файл, когда пользователь нажимает на кнопку на лицевой панели.

1. На блок-диаграмме дважды щелкните по экспресс-ВП Write To Measurement
File, чтобы отобразить диалоговое окно Configure Write To Measurement File.

2. В текстовом поле File Name измените имя файла test.lvm на Selected
Samples.lvm, чтобы сохранить данные в другой файл.

3. Нажмите OK, чтобы сохранить текущую конфигурацию и закрыть диалоговое
окно Configure Write To Measurement File.

4. Щелкните правой кнопкой мыши по входу Signals экспресс-ВП Write To
Measurement File и выберите пункт Insert Input/Output из контекстного меню,
чтобы вставить вход Comment (Комментарий).
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Рисунок 3-6. Блок-диаграмма ВП Save Data



5. Щелкните правой кнопкой мыши по входу Comment экспресс-ВП Write To
Measurement File и выберите Select Input/Output » Enable из контекстного
меню, чтобы заменить вход Comment входом Enable. Входы и выходы
экспресс-ВП появляются в таком же порядке, в котором вы их добавляете.
Чтобы выбрать определенный вход, возможно, сначала придется создать
произвольный, а затем изменить его на тот, который хотите использовать,
щелкая по нему правой кнопкой мыши и выбирая подходящий из меню.

6. Поместите терминал кнопки Write to File слева от экспресс-ВП Write To
Measurement File.

7. Соедините терминал Write to File с входом Enable экспресс-ВП Write To
Measurement File.

Блок-диаграмма должна выглядеть так, как показано на рисунке 3-6.

Просмотр сохраненных данных
Выполните следующие шаги, чтобы просмотреть данные, которые вы сохранили
в файл Selected Samples.lvm.

1. Переключитесь на лицевую панель и запустите ВП. Нажмите кнопку Write to
File несколько раз.

2. Нажмите кнопку STOP на лицевой панели.

3. Откройте файл Selected Samples.lvm с помощью текстового редактора.

Файл Selected Samples.lvm отличается от файла test.lvm.

В test.lvm записались все данные, сгенерированные ВП Save Data, тогда
как в файл Selected Samples.lvm данные записывались только тогда,
когда вы щелкали кнопкой Write to File.

4. Закройте файл после просмотра.

5. Сохраните и закройте ВП.
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Итоги

Элементы управления и индикаторы
Вы можете настраивать элементы управления и индикаторы на лицевой панели
для выполнения определенной задачи вашим ВП. В этой главе вы научились ис-
пользовать элементы управления и индикаторы для выполнения следующих задач:

• Сигнализация возникновения определенных событий. Например, возникнове-
ние предупреждения с помощью светодиодного индикатора, если значение сиг-
нала превышает определенный уровень.

• Управление экспресс-ВП в процессе его выполнения с помощью ввода Enable
и соответствующей кнопки. Вы можете так настроить кнопки, чтобы они работа-
ли в одном из шести режимов, с помощью вкладки Operation в диалоговом окне
Boolean Properties.

Фильтрация данных
Экспресс-ВП Filter пропускает сигнал через фильтры и окна. Вы можете исполь-
зовать Экспресс-ВП Filter, чтобы удалить шум из сигнала.

Сохранение данных
Экспресс-ВП Write To Measurement File сохраняет данные, которые генерирует и
анализирует ВП в .lvm, .tdm или .tdmsфайлы. Файл .lvm– текстовый файл
с разделителем – символом табуляции, который вы можете открыть с помощью
любого редактора электронных таблиц или текста. В .lvm файле LabVIEW со-
храняет данные с точностью до шестого знака. Вместе с данными, которые гене-
рирует экспресс-ВП, .lvm файл включает заголовки, которые содержат инфор-
мацию о данных, такую как дата и время генерации данных. Бинарный файл из-
мерений (.tdm) – двоичный файл, который содержит данные осциллограмм.
Файл .tdm обеспечивает более высокую точность хранения чисел с плавающей
запятой, занимает меньше места на диске и выполняется/открывается быстрее,
чем текстовые файлы .lvm. TDM файл потоковой записи .tdms – двоичный
файл, который обеспечивает более быструю запись, чем файл формата .tdm и
имеет более простой интерфейс для определения свойств.

Среда LabVIEW размещает папку LabVIEW Data в заданном по умолчанию ката-
логе файлов операционной системы, для упрощения организации файлов дан-
ных. Для получения дополнительной информации о записи/чтении данных в/из
.lvm и .tdm файлы обратитесь к справке LabVIEW Help.
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В этой главе вы познакомитесь с экспресс-ВП, которые можно использовать для
получения данных и управления приборами в операционной среде Windows.
Для этих упражнений потребуются технические средства сбора данных.

Для получения информации о сборе данных и коммуникации с приборами под
любой платформой, обратитесь к книге Taking Measurements на вкладке Contents
справки LabVIEW Help.

4
Сбор данных и коммуникация с приборами

В упражнениях данной главы будут использоваться экспресс-ВП DAQ Assistant
(Помощник по сбору данных) для создания задачи DAQmx. DAQmx – это интер-
фейс программирования, который используется для коммуникации с устройст-
вами сбора данных. Для получения информации о других методах создания задач
DAQmx, обратитесь к разделу Getting Started » Getting Started with DAQ » Taking an
NI-DAQmx Measurement in LabVIEW на вкладке Contents справки LabVIEW Help.

В следующих упражнениях вам потребуется инструментальный драйвер DAQmx
и поддерживаемое им устройство.

Список устройств, поддерживаемых драйвером DAQmx, можно найти в докумен-
те NI-DAQ Readme.

Если у вас есть устройство, которое поддерживается только традиционным инст-
рументальным драйвером DAQ, то для получения информации о сборе данных с
помощью традиционного драйвера DAQ (Legacy) обратитесь к книге Taking
Measurements на вкладке Contents справки  LabVIEW Help.

Примечание: Начиная с версии 7.4 драйвера DAQmx, вы можете сымитировать устройство DAQmx в
MAX. Имитируемое устройство DAQmx является программной моделью устройства сбора данных. Об-
ратитесь к справке Measurement & Automation Explorer Help for NI-DAQmx для получения подробных ин-
струкций по созданию имитируемого устройства DAQmx, которым можно пользоваться при выполне-
нии следующих упражнений.

В следующих упражнениях вы создадите DAQmx задачу, которая непрерывно
считывает значения напряжения и выводит их на график осциллограмм.

Выполнение этого упражнения займет у вас около 30 минут.

Создание DAQmx задачи 
В инструментальном драйвере DAQmx под задачей понимается набор из одного
или более каналов, установленных временных характеристик, синхронизации и
других свойств. В общем, задача представляет собой выполняемую операцию по
измерению или генерации сигнала. Например, вы можете создать задачу для из-
мерения температуры в одном или более каналах устройства сбора данных.

Выполните следующие шаги, чтобы создать и настроить задачу, которая считыва-
ет уровень напряжения с помощью DAQ устройства.

1. Откройте новый ВП.

2. На блок-диаграмме, в палитре функций выберите Express » Input, чтобы появи-
лась подпалитра Input.

Получение сигнала



3. В подпалитре Input выберите экспресс-ВП DAQ Assistant, показанный слева, и по-
местите его на блок-диаграмму. После этого запустится помощник по сбору данных
DAQ Assistant и на экране появится диалоговое окно Create New (Создать Новый).

4. Щелкните на Analog Input (Аналоговый ввод), чтобы отобразить опции ввода
аналоговых сигналов.

5. Выберите Voltage (Напряжение) для создания задачи по измерению напряже-
ния в канале аналогового ввода.

В диалоговом окне появится список каналов для каждого из установленных ус-
тройств сбора данных. Число каналов в списке зависит от количества каналов,
которое имеется в устройстве сбора данных.

6. В списке Supported Physical Channels выберите физический канал, в который посту-
пает сигнал, например ai0, и затем нажмите кнопку Finish. Помощник по сбору дан-
ных откроет новое диалоговое окно, показанное на рисунке 4-1, в котором отобра-
зятся опции для настройки канала, который вы выбрали для выполнения задачи.
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7. В разделе Input Range на вкладке Settings, введите 10 для максимального значе-
ния (Max) и -10 для минимального значения (Min).

8. На вкладке Task Timing, выберите опцию N Samples.

9. В текстовое поле Samples To Read введите значение 1000.

Проверка задачи
Для того чтобы проверить, правильно ли сконфигурирован канал, вы можете
протестировать задачу.

Выполните следующие шаги, чтобы убедиться, что данные поступают на устрой-
ство сбора данных.

1. Нажмите кнопку Test, которая показана слева. На экране появится диалоговое
окно DAQ Assistant.

2. Нажмите кнопку Start (Пуск) несколько раз, убедитесь, что данные получены,
затем нажмите кнопку Close, чтобы вернуться к DAQ Assistant.

3. Нажмите кнопку OK, чтобы сохранить текущую конфигурацию и закрыть DAQ
Assistant. LabVIEW автоматически создаст ВП.

4. Сохраните ВП как Read Voltage.vi в заранее определенном месте.

Рисунок 4-1. Конфигурирование задачи
с использованием Помощника по сбору данных



Отображение получаемых данных на индикаторе
Вы можете использовать задачу, созданную в предыдущем примере, для отобра-
жения данных, полученных с помощью DAQ устройства.

Выполните следующие шаги, чтобы построить на графике осциллограмм данные
из канала и изменить название сигнала.

1. На блок-диаграмме, щелкните правой кнопкой мыши по выходу data (данные),
и выберите опцию Create » Graph Indicator из контекстного меню.

2. Переключитесь на лицевую панель и запустите ВП три или четыре раза. Наблю-
дайте за графиком диаграмм. На панели условных обозначений графика(plot leg-
end), находящейся над графическим индикатором, появится слово Voltage.

3. На блок-диаграмме щелкните правой кнопкой мыши по экспресс-ВП DAQ
Assistant и выберите Properties (Свойства) из контекстного меню, чтобы от-
крыть DAQ Assistant .

4. Щелкните правой кнопкой мыши по пункту Voltage в списке каналов и выбе-
рите Rename (Переименовать) из контекстного меню, чтобы появилось диало-
говое окно Rename a channel or channels. 

Подсказка: Также для отображения диалогового окна Rename a channel or channels, можно выбрать на-
звание канала и нажать клавишу <F2>.

5. В текстовое поле New Name введите First Voltage Reading и нажмите на
кнопку OK.

6. Нажмите кнопку OK, чтобы сохранить текущую конфигурацию и закрыть ок-
но DAQ Assistant.

7. Переключитесь на лицевую панель и запустите ВП. В условных обозначениях
графика осциллограмм появится First Voltage Reading.

8. Сохраните ВП.

Редактирование задачи DAQmx
Чтобы иметь возможность сравнивать два разных значения напряжения, можно
добавить в задачу еще один канал. Кроме этого, можно настроить задачу таким
образом, чтобы показания напряжения считывались непрерывно.

Выполните следующие шаги, чтобы добавить новый канал к задаче и настроить
непрерывное получение данных.

1. На блок-диаграмме дважды щелкните по экспресс-ВП DAQ Assistant, чтобы
открыть помощник по сбору данных DAQ Assistant.

2. Нажмите кнопку Add Channels, которая показана слева, и выберите канал
Voltage (Напряжение) из меню Add Channel, чтобы появилось диалоговое окно
Add Channels To Task.

3. Выберите любой неиспользуемый физический канал из списка Supported
Physical Channels и нажмите кнопку OK, чтобы вернуться в DAQ Assistant.

4. Переименуйте канал в Second Voltage Reading.

5. На вкладке Task Timing выберите опцию Continuous. Когда вы устанавливаете
опции временных характеристик и синхронизации в DAQ Assistant, эти опции
применяются ко всем каналам из списка.

6. Нажмите кнопку OK, чтобы сохранить текущую конфигурацию и закрыть DAQ
Assistant. На экране появится диалоговое окно Confirm Auto Loop Creation.

7. Нажмите кнопку Yes. LabVIEW автоматически разместит Цикл по условию вокруг
экспресс-ВП DAQ Assistant и графического индикатора. На блок-диаграмме по-
явится кнопка остановки, соединенная с входом stop экспресс-ВП DAQ Assistant.

Выход stopped экспресс-ВП соединен с терминалом условия выхода из цикла.

Блок-диаграмма должна выглядеть так же, как показано на рисунке 4-2.
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Если во время выполнения этого ВП происходит ошибка или вы нажимаете кноп-
ку стоп, экспресс-ВП DAQ Assistant останавливает чтение данных; выход stopped
возвращает значение TRUE (ИСТИНА) и останавливает Цикл по условию.

Визуальное сравнение двух графиков напряжений
Поскольку на графическом индикаторе изображены два графика напряжения, вы
можете настроить их таким образом, чтоб они визуально различались.

Выполните следующие шаги, чтобы настроить цвет графика на индикаторе.

1. На лицевой панели разверните панель настройки графиков так, чтобы было видно
название обоих графиков.

2. Запустите ВП.

Две кривых появятся на графике, и в панели настройки будут отображаться назва-
ния обеих кривых.

3. Щелкните правой кнопкой мыши по First Voltage Reading в панели настройки гра-
фика и выберите пункт Color (Цвет) из контекстного меню. Используя инструмент
копирования цвета, выберите цвет, например желтый, чтобы график был хорошо
виден. Измените цвет графика Second Voltage Reading.

4. Сохраните ВП.

Коммуникация с приборами
Драйверы приборов упрощают управление прибором и сокращают время разработки
тестовой программы, устраняя потребность изучать протокол программирования
для каждого прибора. Драйверы – это набор подпрограмм для управления
прибором. Каждая подпрограмма соответствует операции, такой как настройка,
чтение/запись и вызов/запуск прибора. Поэтому, если возможно, для управления
приборами пользуйтесь соответствующими драйверами. На сайте компании
National Instruments содержатся тысячи драйверов для обширного набора приборов.
В следующих упражнениях вы будете осуществлять коммуникацию с прибором.

Поиск и установка драйверов приборов (Windows и Linux)
Используйте NI Instrument Driver Finder (Поисковик драйверов приборов), что-
бы найти и установить LabVIEW Plug and Play драйверы приборов, без выхода из
среды разработки LabVIEW.

Примечание: Instrument Driver Finder доступен только в Windows и Linux. Для его использования необ-
ходим доступ в Интернет. Вы также можете посетить сетевой ресурс NI Instrument Driver Network по ад-
ресу ni.com/idnet для поиска драйверов приборов.

Выполните следующие шаги, чтобы найти и установить драйвер прибора, ис-
пользуя Instrument Driver Finder.

1. Выберите пункт Tools » Instrumentation » Find Instrument Drivers или Help » Find
Instrument Drivers чтобы запустить Instrument Driver Finder.

2. Выберите пункт National Instruments из выпадающего меню Manufacturer (Про-
изводитель).
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3. Нажмите кнопку Search. Папки на странице Search Results содержат драйверы
приборов, а их содержимое – это файлы, которые Instrument Driver Finder мо-
жет загрузить и установить. Instrument Driver Finder открывает первую в спис-
ке папку и выбирает файл драйвера. Вы можете щелкать по другим файлам и,
используя подробную информацию в окне справа, выбрать правильный драй-
вер для прибора.

4. Выберите первый файл драйвера из списка Driver и щелкните по кнопке Install.

5. Если у вас нет профиля на сайте ni.com, выберите пункт No, I Need to create a
profile (нет, требуется создать профиль) и нажмите кнопку Create Profile, чтобы
открыть окно браузера, в котором вы сможете создать профиль на сайте ni.com.
Если у вас есть профиль NI.com, переходите к пункту 7.

6. Создайте профиль и вернитесь к Instrument Driver Finder.

7. Выберите Yes (Да), введите адрес вашей электронной почты и пароль и нажми-
те кнопку Login.

8. Нажмите кнопку Close после того, как Instrument Driver Finder загрузит и уста-
новит драйвер прибора в каталог labview\instr.lib и покажет путь к
вновь установленному драйверу.

9. Нажмите кнопку Close, чтобы закрыть Instrument Driver Finder.

Также можно создавать собственные драйверы приборов. 

Для получения дополнительной информации о создании драйверов приборов, об-
ратитесь к разделу Controlling Instruments » Using Instrument Drivers на вкладке
Contents справки LabVIEW Help.

Организация доступа к прибору с помощью Instrument I/O Assistant
Если драйвер для прибора недоступен, тогда для коммуникации с прибором
можно воспользоваться экспресс-ВП Instrument I/O Assistant.

Примечание: Для того чтобы пользоваться экспресс-ВП Instrument I/O Assistant, это приложение не-
обходимо установить. Instrument I/O Assistant устанавливается с компакт-диска National Instruments
Device Drivers.

Выполните следующие шаги, чтобы выбрать прибор, используя экспресс-ВП
Instrument I/O Assistant.

1. Включите прибор, который вы хотите использовать. 

2. Выберите экспресс-ВП  Instrument I/O Assistant в палитре Input и поместите его
на блок-диаграмму. На экране появится диалоговое окно Instrument I/O
Assistant.

3. Нажмите кнопку Show Help, изображенная слева, в верхнем правом углу диало-
гового окна Instrument I/O Assistant. Справа от диалогового окна появится
справка. Верхнее окно справки содержит практические рекомендации по ис-
пользованию Instrument I/O Assistant. Нижнее окно справки содержит инфор-
мацию о компонентах диалогового окна, которая зависит от содержимого.

4. Щелкните по ссылке Select Instrument (Выбор прибора) в верхнем окне справ-
ки и следуйте указаниям в справочном окне, чтобы выбрать прибор, с которым
вы хотите наладить коммуникацию.

5. В случае необходимости, настройте свойства прибора.

6. Если вы хотите свернуть окно справки, нажмите кнопку Hide Help, которая по-
казана слева, в верхнем правом углу диалогового окна Instrument I/O Assistant.
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Краткое изложение
пройденного материала, советы и секреты

Экспресс-ВП DAQ Assistant
Вы можете использовать экспресс-ВП DAQ Assistant, чтобы в интерактивном ре-
жиме создавать каналы измерения или задачи.

Поместите экспресс-ВП DAQ Assistant на блок-диаграмму, чтобы настроить ка-
налы и задачи, пользуясь инструментальным драйвером DAQmx для сбора дан-
ных. DAQmx представляет собой интерфейс программирования, который приме-

Сбор и анализ данных прибора
После того, как вы выбрали прибор, ему можно послать команду на считывание
данных. В этом упражнении вы будете учиться использовать экспресс-ВП
Instrument I/O Assistant, чтобы получить и проанализировать идентификацион-
ную информацию о приборе.

Выполните следующие шаги для коммуникации с прибором.

1. В диалоговом окне Instrument I/O Assistant, щелкните кнопкой Add Step и вы-
берите шаг Query and Parse.

2. В текстовое поле Enter a command введите *IDN?. *IDN? является запросом, ко-
торый распознается большинством приборов. Ответ на него – строка идентифика-
ционного номера, которая описывает прибор. Если прибор не воспринимает эту
команду, посмотрите список разрешенных команд в его справочном описании.

3. Нажмите кнопку Run, которая показана слева. Instrument I/O Assistant пошлет
команду прибору, а прибор вернет свою идентификационную информацию.

4. Выберите пункт ASCII only из выпадающего меню ниже столбца Byte index в
окне ответа, чтобы анализировать название как строку ASCII. 

Вы также можете использовать Instrument I/O Assistant для анализа номеров в
ASCII формате и двоичных данных.

5. Нажмите кнопку Parsing help, которая показана слева, в диалоговом окне
Instrument I/O Assistant, чтобы отобразить информацию о синтаксическом ана-
лизе данных.

6. В столбце ASCII representation окна ответа, щелкните на значение, которое вы
хотите анализировать.

7. В текстовое поле Token name введите название для маркера. Название, которое
вы введете – это выход экспресс-ВП Instrument I/O Assistant, показанный слева.

Создание команды для прибора
После получения данных от прибора, вы можете добавить входной параметр к
команде. Параметр будет входным значением для ВП или функции.

Выполните следующие шаги, чтобы добавить параметр для команды.

1. Нажмите кнопку Add Step и щелкните по шагу Write.

2. В текстовое поле Enter a command введите команду *IDN?.

3. Выберите команду в текстовом поле Enter a command и щелкните кнопкой Add
parameter, чтобы добавить параметр для команды.

4. В текстовое поле Test value введите для параметра значение по умолчанию.

5. В текстовое поле Parameter name введите название параметра. Используйте это
название, чтобы сослаться на параметр в приложении.

6. Нажмите кнопку OK, чтобы сохранить текущую конфигурацию и закрыть ди-
алоговое окно Instrument I/O Assistant.

ni.com/russia 40 Начало работы с LabVIEW

Глава 4       Сбор данных и коммуникация с приборами



няется для коммуникации с устройствами сбора данных. Обратите внимание, что
вы можете использовать экспресс-ВП DAQ Assistant для управления устройства-
ми, поддерживаемыми DAQmx.

Дополнительную информацию об экспресс-ВП DAQ Assistant можно найти в книге
Getting Started » Getting Started with DAQ » Taking an NI-DAQmx Measurement in
LabVIEW, ссылка на которую находится во вкладке Contents справки LabVIEW Help.

Информацию об устройствах, поддерживаемых DAQmx  можно найти в докумен-
те NI-DAQ Readme. Если DAQmx не поддерживает устройство, которое вы хоти-
те использовать, обратитесь к книге Taking Measurements на вкладке Contents
справки LabVIEW Help для получения информации об использовании Traditional
NI-DAQ (Legacy) для сбора данных.

Задачи
В DAQmx под задачей понимается совокупность одного или нескольких каналов,
временных параметров, синхронизации и других свойств. Концептуально, задача
представляет выполняемую операцию по измерению или генерации сигнала.

Например, вы можете настроить набор каналов для операций аналогового ввода.
После того, как вы создаете задачу, можно обращаться к ней вместо того, чтобы
настраивать каналы индивидуально для выполнения операций аналогового вво-
да. После создания задачи, можно добавлять или удалять из нее каналы.

Обратитесь к книге Taking Measurements во вкладке Contents справки LabVIEW
Help для получения дополнительной информации о каналах и задачах.

Драйверы приборов
Используйте поисковик NI Instrument Driver Finder, чтобы найти и установить
LabVIEW Plug and Play драйверы приборов без выхода из среды разработки
LabVIEW.

Драйверы приборов это набор подпрограмм для управления прибором. Каждая
подпрограмма соответствует программной операции, такой как настройка, чте-
ние/запись и вызов/запуск прибора. Всегда, когда это возможно, для управления
приборами пользуйтесь соответствующими драйверами. На сайте компании
National Instruments содержатся тысячи драйверов для обширного набора приборов. 

Для получения дополнительной информации о Instrument Driver Finder, обрати-
тесь к разделу  Controlling Instruments » Using Instrument Drivers во вкладке Contents
справки LabVIEW Help.

Вы также можете посетить ресурс NI Instrument Driver Network на
ni.com/idnet, чтобы найти драйвер для прибора или создать собственный
драйвер.

Для получения дополнительной информации о создании драйверов приборов,
обратитесь к разделу Controlling Instruments » Using Instrument Drivers на вкладке
Contents справки LabVIEW Help. 

Экспресс-ВП Instrument I/O Assistant
Если драйвер прибора недоступен, для коммуникации с этим прибором можно
воспользоваться экспресс-ВП Instrument I/O Assistant. Этот ВП служит для взаи-
модействия с приборами путем обмена текстовыми сообщениями и последую-
щим распознаванием полученного ответа.

Запустите Instrument I/O Assistant, поместив на блок-диаграмму экспресс-ВП
Instrument I/O Assistant или дважды щелкнув по значку экспресс-ВП Instrument
I/O Assistant на блок-диаграмме.

Для получения дополнительной информации о коммуникации с внешним уст-
ройством, обратитесь к справке Instrument I/O Assistant Help, которую можно уви-
деть, нажав кнопку Show Help в диалоговом окне Instrument I/O Assistant.
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В предыдущих главах этого руководства вашему вниманию было представлено
большинство возможностей среды, которые необходимы для создания стандарт-
ных измерительных приложений. По мере изучения среды LabVIEW вам, воз-
можно, потребуется улучшить уже созданные ВП либо более тонко осуществлять
управление процессами, для которых эти ВП были созданы. В этой главе будут
представлены некоторые концепции, с которыми необходимо познакомиться,
прежде чем использовать дополнительные возможности LabVIEW. Для получе-
ния дополнительной информации об этих концепциях, вы можете использовать
раздел Fundamentals, ссылка на который находится на вкладке Contents справки
LabVIEW Help. Раздел Concepts познакомит вас с основными концепция-
ми/принципами программирования в среде LabVIEW. В разделе How-To вы най-
дете пошаговые инструкции по использованию LabVIEW.

5
Использование дополнительных
возможностей LabVIEW

Все элементы управления и индикаторы
Элементы управления и индикаторы, расположенные в подпалитре Express
палитры элементов управления – это только часть полного набора встроенных
элементов управления и индикаторов, доступных в LabVIEW. Поэтому, в других
подпалитрах вы можете найти все элементы управления и индикаторы, которые
можно использовать для создания лицевой панели. Однако, все подпалитры,
кроме подпалитры Express, объединяют элементы управления и индикаторы по
функциональным возможностям вместо того, чтобы иметь отдельно подпалитру
для элементов управления и отдельно для индикаторов.

Например, верхний уровень подпалитры Express содержит подпалитру Numeric
Controls (числовых элементов управления) и подпалитру Numeric Indicators
(числовых индикаторов). А в подпалитрах Modern и Classic эти элементы
управления и индикаторы расположены в одной подпалитре Numeric, потому что
все они – все числовые объекты.

Нажмите на кнопку View на закрепленной палитре Элементов управления и
выберите опцию Always Visible Categories » Show All Categories в контекстном
меню, чтобы отобразить все категории палитры Элементов управления.

Для получения дополнительной информации об использовании полного набора
встроенных элементов управления и индикаторов, вы можете воспользоваться
параграфом Fundamentals » Building the Front Panel, ссылка на которую находится
на вкладке Contents справки LabVIEW Help.
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Все ВП и Функции
Экспресс-ВП и структуры, расположенные в подпалитре Express палитры Функ-
ций, являются частью полного набора встроенных ВП, функций и структур сре-
ды LabVIEW.

Щелкните по кнопке View на прикрепленной палитре Функций и выберите пункт
Always Visible Categories » Show All Categories в контекстном меню, чтобы отобра-
зить все категории палитры Функций.

В среде LabVIEW используется цветовое кодирование иконок, чтобы различать
функции, ВП и экспресс-ВП. Иконки функций имеют бледно-желтый фон,
большинство иконок ВП имеет белый фон, а иконки экспресс-ВП – голубые с
синими полями.

Экспресс-ВП на блок-диаграмме выглядят, как расширяемые узлы с иконками
на голубом фоне. В отличие от экспресс-ВП, большинство функций и ВП на
блок-диаграмме имеют вид просто иконок, а не расширяемых узлов.

ВП
При размещении ВП на блок-диаграмме, эти ВП становятся подприборами
(ВПП). Если дважды щелкнуть по ВПП, появится его лицевая панель, а не диа-
логовое окно настройки. В правом верхнем углу лицевой панели или блок-диа-
граммы отображается иконка этого ВП. Эта иконка будет представлять ВП при
помещении его на блок-диаграмму другого ВП. 

Практически любой созданный ВП вы можете использовать в качестве ВПП. Для
получения дополнительной информации о создании ВПП и трансформации их в
ВПП можно использовать параграф Fundamentals » Creating VIs and SubVIs, ссыл-
ка на который находится на вкладке Contents справки LabVIEW Help.

Вы также можете сохранить сконфигурированный экспресс-ВП в качестве ВПП.
Дополнительную информацию о создании ВПП из экспресс-ВП можно найти
в параграфе Fundamentals » Building the Block Diagram, ссылка на который нахо-
дится на вкладке Contents справки LabVIEW Help.

Функции
Функции – основные исполняемые элементы LabVIEW. В отличие от ВП, функ-
ции не имеют лицевых панелей или блок-диаграмм.



Случаи, в которых используют
дополнительные возможности LabVIEW

Экспресс-ВП, структуры, элементы управления и индикаторы, расположенные в
подпалитре Express палитры элементов управления обеспечивают требуемую
функциональность при создании базовых измерительных приложений.

Ниже приведен список приложений, которые потребует использования ВП,
функций, структур, элементов управления и индикаторов, расположенных в дру-
гих подпалитрах.

•Программно-управляемые свойства и методы среды LabVIEW, ВП, элементов уп-
равления и индикаторов – Вы можете программно управлять поведением ВП во
время выполнения, определять, как выглядят элементы управления или инди-
каторы, либо управлять поведением среды LabVIEW. Для получения дополни-
тельной информации об этих возможностях, вы можете прочитать раздел
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Типы данных
На блок-диаграмме ВП терминалы объектов лицевой панели имеют различные
цвета. Цвет и символ терминала указывают тип данных соответствующего эле-
мента управления или индикатора. Цвета также указывают типы данных провод-
ников, вводов и выводов. Цвет вводов и выводов экспресс-ВП указывает, какие
данные принимаются или передаются.

Типы данных указывают, какие объекты, входы и выходы можно соединять вме-
сте. Например, если переключатель имеет зеленую границу, тогда можно соеди-
нить его с любым входом экспресс-ВП с зеленой меткой. Ручка управления име-
ет оранжевую границу, поэтому ее можно соединить с любым входом экспресс-
ВП с оранжевой меткой. Однако вы не можете присоединить ручку управления к
входу с зеленой меткой. Заметим, что создаваемые проводники имеют тот же
цвет, что и соответствующий терминал.

Для получения дополнительной информации о типах данных вы можете прочи-
тать параграф Fundamentals » Building the Block Diagram, ссылка на который нахо-
дится на вкладке Contents справки LabVIEW Help.

Динамический Тип данных
Динамические данные хранят информацию, сгенерированную или полученную
экспресс-ВП. Динамический тип данных выглядит как темно-синий терминал
(показан слева). Большинство экспресс-ВП принимает или возвращает динами-
ческие данные. Вы можете присоединить динамические данные к любому инди-
катору или вводу, который принимает числовые или логические данные, а также
осциллограммы. Поэтому соединяйте динамические данные с таким индикато-
ром, который сможет лучше всего представить эти данные. Такими индикатора-
ми могут быть графики, развертки и числовые индикаторы.

Большинство других ВП и функций LabVIEW не принимают динамические дан-
ные. Чтобы использовать встроенный ВП или функцию для анализа или обработ-
ки динамических данных, необходимо привести их к числовому или логическо-
му типам либо преобразовать в осциллограмму или массив данных.

Экспресс-ВП Convert from Dynamic Data преобразует динамические данные в
числовой, логический типы, осциллограмму или массив данных для дальнейше-
го использования с другими ВП и функциями. Если вы присоедините динамиче-
ские данные к индикатору массива, LabVIEW автоматически поместит экспресс-
ВП Convert from Dynamic Data на блок-диаграмму.

Справедлива и обратная операция, т.е. экспресс-ВП Convert to Dynamic Data пре-
образует числовой, логический типы, осциллограмму и массивов данных в дина-
мические данные для использования их в экспресс-ВП. 

Для получения дополнительной информации о динамическом типе данных, вы
можете использовать параграф Fundamentals » Building the Block Diagram, ссылка
на который находится на вкладке Contents справки LabVIEW Help.



Fundamentals » Programmatically Controlling VIs, ссылка на который находится на
вкладке Contents справки LabVIEW Help.

•Вызов кода, написанного на текстовом языке программирования – Вы можете ис-
пользовать LabVIEW для взаимодействия с приложениями, написанными на
текстовом языке программирования, такими как C или C++. Для получения
дополнительной информации об этом, вы можете использовать раздел
Fundamentals » Calling Code Written in Text-Based Programming Languages, ссылка
на который находится на вкладке Contents справки LabVIEW Help.

•Управление ВП по сети – Вы можете вызвать ВП, который находится на другом
компьютере, на котором запущена среда LabVIEW. Для получения дополни-
тельной информации об этом, вы можете использовать раздел Fundamentals »
Networking in LabVIEW, ссылка на который находится на вкладке Contents
справки LabVIEW Help.

•Обмен данными в приложении или по сети – Вы можете создать настраиваемые про-
граммные элементы, называемые разделенными переменными (shared variables),
чтобы передавать данные между различными ВП или между областями одного ВП,
которые невозможно соединить проводниками. Для получения дополнительной ин-
формации об этом, вы можете использовать раздел Fundamentals » Networking in
LabVIEW, ссылка на который находится на вкладке Contents справки LabVIEW Help.

•Публикация ВП в сети Интернет – Вы можете опубликовать лицевую панель лю-
бого ВП в сети, и пользователи смогут с ней взаимодействовать. Для получения
дополнительной информации об этом, вы можете использовать раздел
Fundamentals » Networking in LabVIEW, ссылка на который находится на вкладке
Contents справки LabVIEW Help.

•Сохранение данных в файлы различных форматов – В дополнение к формату изме-
рительных файлов, которые в своей основе являются текстовыми, вы можете со-
здавать файлы, которые можно непосредственно использовать в других приложе-
ниях, например электронные таблицы и текстовые файлы. Для получения допол-
нительной информации об этом, вы можете использовать раздел Fundamentals »
File I/O, ссылка на который находится на вкладке Contents справки LabVIEW Help.

•Настройка меню – Можно настроить, какие пункты меню будут появляться при
запуске ВП. Можно также создавать пользовательские меню. Для получения
дополнительной информации об этом, вы можете использовать раздел
Fundamentals » Creating VIs and SubVIs, ссылка на который находится на вклад-
ке Contents справки LabVIEW Help.

•Использование проектов LabVIEW – Проекты LabVIEW применяются для группи-
ровки как файлов среды LabVIEW, так и других приложений, создания специфика-
ций компиляции и загрузки файлов в различные целевые устройства из одного хост
компьютера. Проекты необходимо использовать при создании исполняемых при-
ложений и разделяемых библиотек. Они необходимы при работе с системами ре-
ального времени, с сенсорным управлением (Touch Panel), ПЛИС, PDA, цифровы-
ми сигнальными процессорами и встраиваемыми целевыми устройствами. Допол-
нительную информацию об использовании проектов в перечисленных целях вы
сможете найти в документации к этим специальным модулям. Общую информа-
цию об использовании проектов в среде LabVIEW можно найти в разделе
Fundamentals » Organizing and Managing a Project справки LabVIEW Help.

•Доступ к другим приложениям Windows – Вы можете использовать LabVIEW в ка-
честве клиента .NET или ActiveX, чтобы обратиться к объектам, свойствам, ме-
тодам и событиям, связанным с .NET сервером или приложениями ActiveX. Для
получения дополнительной информации об этих возможностях используйте
раздел Fundamentals » Windows Connectivity справки LabVIEW Help.

•Написание математических формул, уравнений и сценариев – Для выполнения
математических операции на блок-диаграмме вы можете использовать различ-
ные узлы (nodes). С этой целью, а также для написания математических функ-
ций и сценариев, можно применять текстовый язык LabVIEW MathScript. До-
полнительная информация об этом находится в разделе Fundamentals » Formulas
and Equations справки LabVIEW Help.
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Глосарий

A
automatic scaling (автоматическое масштабирование) Возможность шкал автоматически изме-

няться, подстраиваясь под диапазон отображаемых значений. В частности, авто-
масштабирование для шкал графика будет определять их максимальное и мини-
мальное значения.

B
block diagram Графическое представление программы либо алгоритма. Блок диаграмма состоит

из исполняемых узлов (node), изображаемых иконками, и проводников (wire), пе-
редающих данные от узла к узлу. Блок диаграмма является исходным кодом вирту-
ального прибора и отображается в специальном окне ВП - окне блок-диаграмм.

Boolean controls/indicators Объекты лицевой панели, предназначенные для операций и отображения логи-
ческих данных (ИСТИНА или ЛОЖЬ).

broken Run button Видоизменение кнопки запуска при неисправности ВП вследствие возникнове-
ния ошибок.

broken VI ВП, который не может выполняться вследствие возникновения ошибок. Свиде-
тельством этого является разорванная стрелка на кнопке запуска ВП. 

C
channel (канал) 1. Физический - терминал или контакт, на который подается аналоговый либо

цифровой сигнал при измерении или генерации. Один физический канал может
содержать более одного терминала, что происходит в случае дифференциальной
конфигурации аналогового ввода или цифрового порта, состоящего из восьми
линий. Наименование физического канала счетчика (counter) представляет со-
бой исключение, поскольку не является именем терминала, на котором счетчик
измеряет или генерирует цифровой сигнал.

2. Виртуальный - совокупность настроек, таких как имя, физический канал, под-
ключения входных терминалов, тип измерения либо генерации и информация о
масштабе. Виртуальные каналы NI-DAQmx можно определить либо, не привязы-
ваясь к какой-либо задаче (глобальный канал), либо как часть конкретной зада-
чи (локальный канал). Настройка виртуальных каналов не является обязательной
процедурой при использовании устаревшего драйвера Traditional NI-DAQ в отли-
чие от драйвера NI-DAQmx. При использовании Traditional NI-DAQ настройка
каналов происходит в утилите MAX. В NI-DAQmx вы можете настраивать вирту-
альные каналы либо в MAX, либо непосредственно в программе, и при этом на-
стройка может являться как частью задачи, так и выполняться отдельно.

3. Переключателя (Switch) - канал переключателя представляет любую точку под-
ключения переключателя. Канал может состоять из одного или нескольких сиг-
нальных проводов (обычно один, два или четыре) в зависимости от топологии
переключателя. Для канала переключателя нельзя создать виртуальный канал.
Каналы переключателя могут использоваться только совместно с функциями и
ВП из библиотеки NI-DAQmx Switch.

checkbox В диалоговом окне небольшое квадратное поле, в котором можно ставить либо
снимать отметку. Обычно служат для независимого выбора из некоторого набора
опций.

conditional terminal Терминал Цикла по условию (While Loop), принимающий логическое значение,
которое определяет, будет ли цикл выполняться еще раз.

Context Help window Окно, отображающее основную информацию об объекте LabVIEW, над которым
в данный момент находится курсор мыши. Такими объектами могут быть ВП,

ni.com/russia 46 Начало работы с LabVIEW

(блок-диаграмма)

(логические элементы
управления/индикаторы)

(неисправный ВП)

(терминал условия выхода)

(Окно Контекстной Справки)

(неисправная кнопка
запуска ВП)



функции, константы, структуры, палитры, свойства, методы, события или ком-
поненты диалоговых окон. 

control (Элемент управления) Объект лицевой панели для ввода данных интерактивно в ВП или программно в ВПП.
Примерами таких объектов являются ручки управления, кнопки, ползунки и т.д.

Controls palette Палитра, содержащая элементы управления, индикаторы и элементы оформле-
ния лицевой панели. 

current VI ВП, чья лицевая панель, блок-диаграмма или редактор иконки (Icon Editor) яв-
ляется активным окном.

D
DAQ См. data acquisition (сбор данных).

DAQ Assistant Графический интерфейс для настройки измерительных задач, каналов и масштабов.

DAQ device Устройство для получения или генерации данных. Может содержать несколько
каналов и схемы преобразования. DAQ устройствами являются встраиваемые
платы, PCMCIA карты, а также DAQPad устройства, подключаемые к компьюте-
ру посредством порта USB или IEEE 1394 (FireWire). Модули SCXI также счита-
ются DAQ устройствами.

data acquisition (DAQ) 1. Получение и измерение аналоговых или цифровых сигналов с датчиков, изме-
рительных преобразователей и пробников.

2. Генерация аналоговых или цифровых электрических сигналов.

data flow (поток данных) Принцип программирования, состоящий в том, что исполняемые узлы начнут
выполняться только после получения всех необходимых входных данных. В ре-
зультате исполнения узлы автоматически генерируют выходные данные. Среда
LabVIEW подчиняется данному принципу, поэтому порядок выполнения ВП и
функций на блок-диаграмме определяется движением данных через узлы. 

data type (тип данных) Формат представления информации. В среде LabVIEW для большинства ВП и
функций приняты следующие типы данных: числовой (numeric), массив (array),
строка (string), логический (Boolean), путь (path), ссылка (refnum), перечисление
(enumeration), осциллограмма (waveform) и кластер (cluster).

DC Постоянный ток.

default Значение, принятое по умолчанию. Многие входы ВП используют значения по
умолчанию в случае, если они не заданы. 

device (устройство) Прибор либо контроллер, к которому вы можете обращаться как к отдельному объ-
екту, предназначенному для управления или наблюдения за реальными процесса-
ми. Устройство часто подключается к хост компьютеру посредством определенно-
го интерфейса для передачи данных. См. также DAQ device и measurement device.

drag Способ использования курсора мыши для выбора, перетаскивания, копирования
или удаления объектов. 

driver Программное обеспечение для управления определенным устройством, таким
как DAQ устройство.

dynamic data type Тип данных, который используется в экспресс-ВП и состоит из выборок сигнала
и атрибутов. Атрибуты содержат определенную информацию о сигнале, такую
как имя сигнала либо дату и время получения сигнала. Они определяют вид сиг-
нала на графике или развертке осциллограмм. 

E
Error list window Окно, в котором отображаются ошибки и предупреждения, имеющие место в

ВП, и, в некоторых случаях, рекомендации по устранению ошибок.
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error message Сообщение о неисправной работе программного или аппаратного обеспечения
либо о попытке подачи на вход функции недопустимых данных.

Express VI (экспресс-ВП) ВПП, предназначенный для решения стандартных измерительных задач. Настра-
ивается с помощью диалогового окна настройки.

F
For Loop Циклическая структура, выполняющая свою поддиаграмму (тело цикла) опреде-

ленное количество раз. Эквивалентна следующему коду в текстовых языках про-
граммирования: For i = 0 to n - 1, do....

front panel (лицевая панель) Интерактивный интерфейс пользователя ВП. Вид лицевой панели имитирует па-
нель управления приборов, таких как осциллограф и мультиметр. 

function (функция) Встроенный исполняемый элемент, похожий на оператор, функцию или проце-
дуру в текстовых языках программирования. 

Functions palette Палитра, содержащая ВП, функции, структуры и константы.

G
General Purpose Interface Bus GPIB (КОП). Является синонимом HP-IB. Стандартная шина для управления

электронными приборами с помощью компьютера. Известна также под именем
шины IEEE 488, поскольку определяется стандартами ANSI/IEEE 488-1978,
488.1-1987 и 488.2-1992.

graph (график) Двумерное отображение одной или нескольких кривых. График получает и стро-
ит данные как единое целое.

I
I/O Ввод/вывод.Передача данных в/из компьютерной системы, включая каналы пе-

редачи, устройства ввода команд и/или интерфейсы сбора данных и управления. 

icon (иконка) Графическое представление узла на блок-диаграмме.

indicator (индикатор) Объект лицевой панели для отображения результатов операции, например, гра-
фик или светодиодный индикатор. 

instrument driver Набор высокоуровневых функций для управления и коммуникации с прибором.

Instrument I/O Assistant Дополнительное приложение, которое запускается при выборе экспресс-ВП
Instrument I/O Assistant, предназначенное для коммуникации с приборами, уп-
равляемыми с помощью текстовых сообщений, и анализа ответной информации.

L
.lvm файл Текстовый файл измерений с разделителем - символом табуляции, который мож-

но открыть с помощью любого приложения для чтения и редактирования текста
и таблиц.

label (ярлык) Текстовый объект, используемый для наименования или описания объектов (об-
ластей) лицевой панели или блок-диаграммы.

LabVIEW Laboratory Virtual LabVIEW - графический язык программирования, в котором для создания про-
граммы вместо линий текста используются иконки.

LED Светодиод.

legend Объект, принадлежащий графику или развертке осциллограмм, для отображения
имени и стиля кривых.

M
MAX Смотри Measurement & Automation Explorer.
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Measurement & Windows приложение для настройки и диагностики оборудования компании
National Instruments.

measurement device Устройство сбора данных, такое как многофункциональная плата E серии, SCXI
модули согласования сигналов и модули переключателей.

menu bar (панель меню) Горизонтальная панель со списком наименований основных меню для приложения.
Расположена ниже строки заголовка. Каждое приложение имеет свою панель меню,
однако некоторые меню и опции являются общими для большинства приложений. 

N
NI-DAQ Драйверное программное обеспечение, идущее в комплекте со всеми устройства-

ми NI DAQ и компонентами для согласования сигналов. NI-DAQ представляет
собой обширную библиотеку ВП и функций ANSI C, которые можно вызывать из
различных сред разработки приложений, например, LabVIEW, для программиро-
вания измерительных устройств NI.

NI-DAQmx Последняя версия инструментального драйвера NI-DAQ с новым набором ВП,
функций и средств разработки для управления измерительными устройствами.
Преимуществом NI-DAQmx над предыдущими версиями NI-DAQ является нали-
чие помощника DAQ Assistant для настройки каналов и измерительных задач, ко-
торый облегчает использование устройства в средах LabVIEW, LabWindows™/CVI™
и Measurement Studio. NI-DAQmx обладает возможностью моделирования боль-
шинства поддерживаемых устройств для отладки приложений без непосредствен-
ной установки оборудования в компьютер. NI-DAQmx предлагает более простой и
интуитивно понятный API для создания приложений сбора данных с помощью
меньшего количества функций и ВП, чем в ранних версиях NI-DAQ.

node (узел) Исполняемый элемент программы. Узлы являются аналогами операторов, функ-
ций и процедур в текстовых языках программирования. На блок-диаграмме узла-
ми являются функции, структуры и ВПП.

numeric controls and indicators Объекты лицевой панели для манипуляции и отображения числовых данных.

O
object (объект) Общие наименование любого элемента лицевой панели и блок-диаграммы,

включая элементы управления, индикаторы, структуры, узлы, проводники и им-
портированные рисунки.

Operating tool Инструмент для ввода данных или операций над ними. 

P
palette (палитра) Отображает объекты или инструменты, которые используются для создания ли-

цевой панели или блок-диаграммы.

plot (кривая) Графическое представление массива данных на графике или развертке осцилло-
грамм. 

Positioning tool Инструмент для перемещения и изменения размеров объектов.

project (проект) Набор файлов, которые можно использовать для создания спецификаций ком-
пиляции и ее загрузки в целевое устройство.

Project Explorer window Окно, в котором вы можете создавать и редактировать проекты LabVIEW.
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Properties dialog boxes Диалоговые окна, доступ к которым осуществляется из контекстного меню эле-
мента управления или индикатора. Используются для настройки внешнего вида
элемента управления/индикатора.

pull-down menus Меню, расположенные на соответствующей панели. Пункты меню обычно явля-
ются общими.

PXI PCI eXtensions Модульная компьютерная измерительная платформа. 

R
RMS (СКО) Среднеквадратичное отклонение.

S
sample (выборка) Одна точка данных при получении/генерации аналогового/цифрового сигнала.

scale (шкала) Элемент графика, развертки и некоторых числовых элементов управления/инди-
каторов, содержащий набор маркеров или точек с заданными интервалами для
определения единиц измерения.

shortcut menu Меню, вызываемое щелчком правой кнопкой мыши на объекте. Это меню явля-
ется специфичным для каждого объекта.

string (строка) Текстовое представление данных.

structure (структура) Элемент управления выполнением программы, такой как Flat Sequence structure
(плоская структура Последовательности), Stacked Sequence structure (стековая
структура Последовательности), Case structure (структура Варианта), For Loop
(цикл с фиксированным числом итераций), While Loop (цикл по условию) или
Timed Loop (временной цикл).

subpalette (подпалитра) Палитра, доступ к которой осуществляется из другой палитры, расположенной
выше в иерархическом дереве.

subVI (ВПП) ВП, используемый на блок-диаграмме другого ВП. Аналог подпрограммы.

T
.tdm файл Двоичный измерительный файл, содержащий данные осциллограммы.

.tdms файл Файл TDM Streaming. Двоичный файл с более быстрой записью на диск по срав-
нению с .tdm файлом и предоставляющий более простой интерфейс для задания
свойств.

task (задача) Совокупность одного или более каналов, временных характеристик, триггеров и
других свойств в NI-DAQmx. Задача представляет собой выполняемую операцию
по измерению или генерации сигнала.

template VI (Шаблон ВП) ВП, содержащий наиболее распространенные элементы управления и индикато-
ры, с помощью которого вы можете создать различные ВП с похожей функцио-
нальностью. Шаблоны ВП можно найти в диалоговом окне New.

terminal (терминал) Объект (область) в узле, через который проходят данные.

tip strip (подсказка) Небольшое текстовое поле желтого цвета, идентифицирующее имя терминала и,
таким образом, облегчающее подключение к нему проводника.

tool (инструмент) Режим работы курсора для выполнения определенных операций.

toolbar (линейка инструментов) Линейка, содержащая кнопки управления для запуска и отладки ВП.

Traditional NI-DAQ (Legacy) Устаревшая версия драйвера для разработки приложений сбора данных и управ-
ления старыми DAQ устройствами National Instruments. Используются только в
случае особой необходимости. Дополнительную информацию о случаях исполь-
зования драйвера Traditional NI-DAQ (Legacy), а также полный список поддержи-
ваемых устройств, операционных систем, версий программного обеспечения и
языков программирования можно найти в документе NI-DAQ Readme.
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V
VI Смотри virtual instrument (VI).

virtual instrument (VI) Программа, написанная в среде LabVIEW, которая моделирует внешний вид и
функциональность обычного прибора.

VXI Расширение шины VME для измерительных приложений.

W
waveform (осциллограмма) Набор значений напряжений, считанных с заданной частотой выборки.

waveform chart Индикатор для построения на графике точек данных с определенной частотой.

While Loop (Цикл по условию) Циклическая структура, повторяющая участок кода (тело цикла) до тех пор, пока
не будет выполнено определенное условие. 

wire (проводник) Путь данных между узлами.

Wiring tool Инструмент для задания путей данных между терминалами.
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